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Introduction
In the beginning there was the idea....The proposal to write about every single Microsoft 
Excel function with interesting and comprehensible examples came from Helmut Reinke—
and everyone on the team agreed. “Yes, this is what Excel users need—a comprehensive 
reference book with all of the functions.” That was eight years ago, and the enthusiasm 
hasn’t diminished.

At the beginning of this year, the idea to translate our reference book into English arose. 
And what could we say? There they were again: the same enthusiasm as in 2007, and along 
with it the tremendous task of translation. But we have persevered, and now we are really 
proud and happy to present to you the first edition of our function book in English. Since 
we wrote the German edition, a couple of small Excel revolutions took place: A few years 
ago, Excel 2007 was launched with many new properties and possibilities. For a year and a 
half now, we also have had Excel 2010 at our disposal, which includes even more new pos-
sibilities. We will address them partially in this book.

We hope that you, dear reader, will welcome this concept, and that this reference work will 
give you many ideas and support you when needed.

Who This Book Is For
Functions are the most powerful tools in Excel. Our goal is to give readers an understand-
ing of every single function with the aid of plausible examples so that everyone can be 
capable of realizing the inexhaustible possibilities.

So this book is aimed at everyone who is interested in working with Excel—whether you are 
a beginner or a power user and whether you are using Excel privately or for business. We 
want to make readers with little experience familiar with the functions so that they will find 
meaningful scenarios for using them. But we also want to address the reader who is more 
familiar with Excel, and so we provide several scenarios to help that reader move to the 
next level of knowledge.

Do you want to calculate the probability of winning the lottery? Do you have to provide a 
meaningful report of your company’s annual sales? No problem. Let’s get started.

Assumptions About You

We make a basic assumption that you are generally experienced in working with Microsoft 
Office and know a few Excel basics. We do not spend time explaining the user interface of 
Excel and the buttons on the ribbon.
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If you are an experienced Excel user, you can just skim over Chapter 1, “Solving Prob-
lems with Functions,” and Chapter 2, “Using Functions and PowerPivot.” If you are not so 
experienced, we hope to give you an idea of the general possibilities offered by Excel. 
We hope that the many pages you have in front of you will be helpful to you. Use them 
to your advantage, and if you like the book, please don’t keep your opinion to your-
self. Write to us and let us know what you like about it, and especially what we should 
improve.

We promise that we will be here for you if you have questions or are running into prob-
lems. You can write to us at: info@mindbusiness.de.

How This Book Is Organized
All the functions have been tested in Microsoft Office Excel 2000 through Excel 2010. 
With the exception of characteristics specific to Excel 2007 and Excel 2010, most descrip-
tions can even be used with Excel 97. Where necessary, we added comments regarding 
the particularities of the different versions.

The book is divided into four sections. 

Introducing Formulas and Functions in Excel

The first section contains Chapters 1 through 4. They describe working with Excel, provide 
a general introduction to using Excel 2010, and give you a first look at formulas and func-
tions. For beginners and experts alike, we have outlined the use of formulas and table 
functions with all the important notes, instructions, tips, and tricks.

Because we consider the Excel 2010 PowerPivot add-in quite extraordinary, we have intro-
duced it briefly in this section. It has relatively little to do with spreadsheet functions, but 
we still wanted to acquaint you with it.

Creating Your Own Solutions in Excel

Chapter 5, “Functions in Special Operations,” and Chapter 6, “Custom Functions,” show 
that you can do a lot more with most functions than just use them in a worksheet. You 
can create and program your own functions.

Chapter 5 provides examples for using special functions in names and conditional format-
ting, as well as for validity and data checks. We hope you will find many ideas and clues 
for your own Excel solutions here.
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Chapter 6 introduces you to programming in Excel. You can create any custom functions in 
Excel and then use them just like the built-in functions. 

Functions

Chapters 7 through 17 provide the descriptions of the main Excel functions:

●	 Chapter 7, “Date and Time Functions”

●	 Chapter 8, “Text and Data Functions”

●	 Chapter 9, “Logical Functions”

●	 Chapter 10, “Lookup and Reference Functions”

●	 Chapter 11, “Information Functions”

●	 Chapter 12, “Statistical Functions”

●	 Chapter 13, “Database Functions”

●	 Chapter 14, “Cube Functions” (new in Excel 2007)

●	 Chapter 15, “Financial Functions”

●	 Chapter 16, “Mathematical and Trigonometry Functions”

●	 Chapter 17, “Engineering Functions”

Appendices

This book includes three appendices: Appendix A and Appendix B list the functions alpha-
betically and categorically (respectively), and Appendix C explains what is new in Excel 2007 
and Excel 2010.

And now we wish you lots of success for your work with Microsoft Excel!
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Features and Conventions Used in This Book
This book uses special text and design conventions to make it easier for you to find the 
information you need.

Text Conventions
Convention Meaning

Abbreviated commands 
for navigating the 
ribbon 

For your convenience, this book uses abbreviated commands. 
For example, “Click Home, Insert, Insert Cells” means that you 
should click the Home tab on the ribbon, then click the Insert 
button, and finally click the Insert Cells command.

Boldface type Boldface indicates text that you type.
Initial Capital Letters The first letters of the names of tabs, dialog boxes, dialog box 

elements, and commands are capitalized. Example: the Save As 
dialog box. 

Italicized type Italicized type indicates new terms. 
Plus sign (+) in text Keyboard shortcuts are indicated by a plus sign (+) separating 

key names. For example, Ctrl+Alt+Delete means that you press 
the Ctrl, Alt, and Delete keys at the same time.

Design Conventions

INSIDE OUT  An example of an “Inside Out” heading

These are the book’s signature tips. In these tips, you get the straight scoop on what’s 
going on with the software—inside information about why a feature works the way it 
does. You’ll also find handy workarounds to deal with software problems. 

Sidebar
Sidebars provide helpful hints, timesaving tricks, or alternative procedures related to 
the task being discussed. 

See Also  Cross-references point you to locations in the book that offer additional informa-
tion about the topic being discussed.
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CAUTION!
Cautions identify potential problems that you should look out for when you’re com-
pleting a task or that you must address before you can complete a task.

Note
Notes offer additional information related to the task being discussed.

Certain parts of the text are specially marked to draw your attention to important com-
ments. We have used the following categories:

Category	 Meaning
Note	 Additional information about this topic that’s worth knowing
Important	 Makes you aware of facts you must know and keep in mind
Tip	 Tips and tricks regarding the current context

Your Companion eBook
The eBook edition of this book allows you to:

●	 Search the full text

●	 Print

●	 Copy and paste

To download your eBook, please see the instruction page at the back of this book. 

Using the Sample Files
You’ll find the sample files that are used in this book at:

http://www.microsoftpressstore.com/title/9780735658028

Important
The Microsoft Excel 2010 software is not available from this website. You should pur-
chase and install that software before using this book.

http://www.microsoftpressstore.com/title/9780735658028
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Tip
Microsoft offers special updates and file converters for opening an Excel 2007 and 
Excel 2010 workbook in a previous Excel versions (97–2003). If the converters are not 
installed with the Office update, you might be prompted to install them when opening 
an Excel 2007 or Excel 2010 workbook.

After you install the updates and the converter, you can open Excel 2007 and Excel 
2010 workbooks. You can edit and save the workbooks. However, the new features and 
formats of Excel 2007 and Excel 2010 are not displayed in previous Excel versions. You 
will find detailed information at the following Microsoft website: http://office.microsoft.
com/en-us/excel/HA100775611031.aspx

You should also read the information that is provided for the sample files in each chapter.

The following table lists the names of the sample files that are used in the book. Because 
some users who are working with older Excel versions (Excel 2000 through Excel 2003) 
might not be able to open the new file formats of Excel 2007 and Excel 2010 (.xlsx, .xlsm, 
and so on), the sample files are provided in both formats: .xls (Excel 97 through Excel 2003) 
and .xlsx (Excel 2007 and Excel 2010). 

Important
When you open a sample file in Excel and then close Excel, you can save the file in the 
same format or in a different format. By default, Excel offers the standard format again. 
However, if you choose the standard format (*.xlsx), Excel will display a message box 
that contains the information that you are going to save your work as a macro-free 
workbook. You should click No and save your work in a macro-enabled file type (*.xlsm).

Chapter 
Folder

Workbook/Worksheet Name Location and/or Description

Chapter01 Excel_Example.xls or  
Excel_Example.xlsx

Chapter01 folder

Excel_Pivot_Data.xls or  
Excel_Pivot_Data.xlsx

Chapter01 folder

Chapter02 InformationFunctions.xls or  
InformationFunctions.xlsx

Chapter02 folder

Date_Time.xls or Date_Time.xlsx Chapter02 folder
Text_Data.xls or Text_Data.xlsx Chapter02 folder
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Chapter 
Folder

Workbook/Worksheet Name Location and/or Description

DifferentialCalculation.xls or  
DifferentialCalculation.xlsx

Chapter02 folder

Lookup.xls or Lookup.xlsx Chapter02 folder
Practice_Statistics.xls or  
Practice_Statistics.xlsx

Chapter02 folder

DBFunction empty.xls or  
DBFunction empty.xlsx

Chapter02 folder

Practice_Database.xls or  
Practice_Database.xlsx

Chapter02 folder

Financial mathematics.xls or  
Financial mathematics.xlsx

Chapter02 folder

Math.xls or Math.xlsx Chapter02 folder
Chapter03 Arithmetic Operators Chapter03.xls or Chapter03.xlsx

Priority Chapter03.xls or Chapter03.xlsx
Comparison Operators Chapter03.xls or Chapter03.xlsx
Text Operator Chapter03.xls or Chapter03.xlsx
Relative Reference Chapter03.xls or Chapter03.xlsx
Absolute Reference Chapter03.xls or Chapter03.xlsx
Mixed Reference Chapter03.xls or Chapter03.xlsx
Array Formula Chapter03.xls or Chapter03.xlsx

Chapter05 Fct_Names Chapter05_Names.xls or  
Chapter05_Names.xlsx

Comparison Chapter05_CF.xls or Chapter05_CF.xlsx
Training Chapter05_Names.xls or  

Chapter05_Names.xlsx
Weekend Chapter05_CF.xls or Chapter05_CF.xlsx
Holidays Chapter05_CF.xls or Chapter05_CF.xlsx
Accident1, Accident2 Chapter05_CF.xls or Chapter05_CF.xlsx
Print Layout Chapter05_CF.xls or Chapter05_CF.xlsx
Top3 Chapter05_CF.xls or Chapter05_CF.xlsx
Empty Chapter05_CF.xls or Chapter05_CF.xlsx
Credit Chapter05_CF.xls or Chapter05_CF.xlsx
Groups Chapter05_CF.xls or Chapter05_CF.xlsx
Subtotals Chapter05_CF.xls or Chapter05_CF.xlsx
Depending list, Paygrouplist Chapter05_DV.xls or Chapter05_DV.xlsx
Duplicates Chapter05_DV.xls or Chapter05_DV.xlsx
Completed Chapter05_DV.xls or Chapter05_DV.xlsx
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Chapter 
Folder

Workbook/Worksheet Name Location and/or Description

Chapter06 Circle Geometry.xls or Geometry.xlsm
Fundamentals Geometry.xls or Geometry.xlsm
Quadrilateral Geometry.xls or Geometry.xlsm
Sector of a circle Geometry.xls or Geometry.xlsm

Chapter07 WORKDAY Date_Time.xls or Date_Time.xlsx 
WORKDAY.INTL Date_Time.xlsx
Practice Date_Time.xls or Date_Time.xlsx
YEARFRAC Date_Time.xls or Date_Time.xlsx
DATEDIF Date_Time.xls or Date_Time.xlsx
DATE Date_Time.xls or Date_Time.xlsx
DATEVALUE Date_Time.xls or Date_Time.xlsx
EDATE Date_Time.xls or Date_Time.xlsx
TODAY Date_Time.xls or Date_Time.xlsx
YEAR Date_Time.xls or Date_Time.xlsx
NOW Date_Time.xls or Date_Time.xlsx
WEEKNUM Date_Time.xls or Date_Time.xlsx
MINUTE Date_Time.xls or Date_Time.xlsx
MONTH Date_Time.xls or Date_Time.xlsx
EOMONTH Date_Time.xls or Date_Time.xlsx
NETWORKDAYS Date_Time.xls or Date_Time.xlsx
NETWORKDAYS.INTL Date_Time.xlsx
SECOND Date_Time.xls or Date_Time.xlsx
HOUR Date_Time.xls or Date_Time.xlsx
DAY Date_Time.xls or Date_Time.xlsx
DAYS360 Date_Time.xls or Date_Time.xlsx
WEEKDAY Date_Time.xls or Date_Time.xlsx
TIME Date_Time.xls or Date_Time.xlsx
TIMEVALUE Date_Time.xls or Date_Time.xlsx

Chapter08 ASC Text_Data.xls or Text_Data.xlsx
BAHTTEXT Text_Data.xls or Text_Data.xlsx
CODE Text_Data.xls or Text_Data.xlsx
DOLLAR Text_Data.xls or Text_Data.xlsx
REPLACE Text_Data.xls or Text_Data.xlsx
FIXED Text_Data.xls or Text_Data.xlsx
FIND Text_Data.xls or Text_Data.xlsx
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Chapter 
Folder

Workbook/Worksheet Name Location and/or Description

TRIM Text_Data.xls or Text_Data.xlsx
UPPER Text_Data.xls or Text_Data.xlsx
PROPER Text_Data.xls or Text_Data.xlsx
EXACT Text_Data.xls or Text_Data.xlsx
LOWER Text_Data.xls or Text_Data.xlsx
LEN Text_Data.xls or Text_Data.xlsx
LEFT Text_Data.xls or Text_Data.xlsx
RIGHT Text_Data.xls or Text_Data.xlsx
CLEAN Text_Data.xls or Text_Data.xlsx
SEARCH Text_Data.xls or Text_Data.xlsx
T Text_Data.xls or Text_Data.xlsx
MID Text_Data.xls or Text_Data.xlsx
TEXT Text_Data.xls or Text_Data.xlsx
CONCATENATE Text_Data.xls or Text_Data.xlsx
SUBSTITUTE Text_Data.xls or Text_Data.xlsx
VALUE Text_Data.xls or Text_Data.xlsx
REPT Text_Data.xls or Text_Data.xlsx
CHAR Text_Data.xls or Text_Data.xlsx

Chapter09 Samples Logical_values.xls or Logical_values.xlsx
Properties and Interpretation Logical_values.xls or Logical_values.xlsx
IF Logical_values.xls or Logical_values.xlsx

Chapter10 Address.xls or Address.xlsx Chapter10 folder
Offset.xls or Offset.xlsx Chapter10 folder
References.xls or References.xlsx Chapter10 folder
Misc References.xls or References.xlsx
Index References.xls or References.xlsx
MTRANS References.xls or References.xlsx
exampleRTD.xls, exampleRTD.xlsx, 
or exampleRTD.xlsm,  
exampleRTD.dll

Chapter10 folder

Column-Row References.xls or References.xlsx
LOOKUP Lookups.xls or Lookups.xlsx
test.doc or test.docx Chapter10 folder
VLOOKUP Lookups.xls or Lookups.xlsx
MATCH Lookups.xls or Lookups.xlsx
HLOOKUP Lookups.xls or Lookups.xlsx
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Chapter 
Folder

Workbook/Worksheet Name Location and/or Description

Chapter11 Misc Informations.xls or Informations.xlsm
Error Informations.xls or Informations.xlsm
Info Informations.xls or Informations.xlsm
IS-functions Informations.xls or Informations.xlsm
ISEVEN Informations.xls or Informations.xlsm
ISODD Informations.xls or Informations.xlsm
NA Informations.xls or Informations.xlsm
Cell Informations.xls or Informations.xlsm

Chapter12 INTERCEPT Regression.xls or Regression.xlsx 
RSQ Regression.xls or Regression.xlsx
BETAINV or BETA.INV Probability.xls or Probability.xlsx
BETADIST or BETA.DIST Probability.xls or Probability.xlsx
BINOM.INV Probability.xlsx
BINOMDIST or BINOM.DIST Probability.xls or Probability.xlsx
CHIINV or CHI.INV Probability.xls or Probability.xlsx
CHISQ.INV or CHISQ.INV.RT Probability.xlsx
CHITEST or CHI.TEST or  
CHISQ.TEST

Probability.xls or Probability.xlsx

CHIDIST or CHISQ.DIST or  
CHISQ.DIST.RT

Probability.xls or Probability.xlsx

CRITBINOM Probability.xls or Probability.xlsx
EXPONDIST or EXPON.DIST Probability.xls or Probability.xlsx
FINV or F.INV or F.INV.RT Probability.xls or Probability.xlsx
FISHER Probability.xls or Probability.xlsx
FISHERINV or FISHER.INV Probability.xls or Probability.xlsx
FTEST or F.TEST Probability.xls or Probability.xlsx
FDIST or F.DIST or F.DIST.RT Probability.xls or Probability.xlsx
GAMMAINV or GAMMA.INV Probability.xls or Probability.xlsx
GAMMALN Probability.xls or Probability.xlsx
GAMMALN.PRECISE Probability.xls or Probability.xlsx
GAMMADIST or GAMMA.DIST Probability.xls or Probability.xlsx
GEOMEAN Average.xls or Average.xlsx
TRIMMEAN Average.xls or Average.xlsx
ZTEST or Z.TEST Probability.xls or Probability.xlsx
HARMEAN Average.xls or Average.xlsx
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Folder

Workbook/Worksheet Name Location and/or Description

Web access WEBACCESS.xls or WEBACCESS.xlsx
COUNT Count.xls or Count.xlsx
COUNTA Count.xls or Count.xlsx
COUNTBLANK Count.xls or Count.xlsx
FREQUENCY Count.xls or Count.xlsx
HYPGEOMDIST or  
HYPGEOM.DIST

Probability.xls or Probability.xlsx

LARGE Count.xls or Count.xlsx
SMALL Count.xls or Count.xlsx
CONFIDENCE or  
CONFIDENCE.NORM

Probability.xls or Probability.xlsx

CONFIDENCE.T Probability.xls or Probability.xlsx
CORREL Probability.xls or Probability.xlsx
COVAR Regression.xls or Regression.xlsx
COVARIANCE.P Regression.xls or Regression.xlsx
COVARIANCE.S Regression.xls or Regression.xlsx
KURT Symmetry.xls or Symmetry.xlsx
LOGINV or LOGNORM.INV Probability.xls or Probability.xlsx
LOGNORMDIST or  
LOGNORM.DIST

Probability.xls or Probability.xlsx

MAX&MIN Count.xls or Count.xlsx

MAXA&MINA Count.xls or Count.xlsx
MEDIAN Average.xls or Average.xlsx
AVEDEV Variance.xls or Variance.xlsx
AVERAGE Average.xls or Average.xlsx
AVERAGEA Average.xls or Average.xlsx
AVERAGEIF Average.xls or Average.xlsx
AVERAGEIFS Average.xlsx
MODE or MODE.SNGL Average.xls or Average.xlsx
MODE.MULT Average.xlsx
NEGBINOMDIST or  
NEGBINOM.DIST

Probability.xls or Probability.xlsx

NORMINV or NORM.INV Probability.xls or Probability.xlsx
NORMSINV or NORM.S.INV Probability.xls or Probability.xlsx
NORMDIST, NORMSDIST or 
NORM.DIST or NORM.S.DIST

Probability.xls or Probability.xlsx
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PEARSON Regression.xls or Regression.xlsx
POISSON or POISSON.DIST Probability.xls or Probability.xlsx
PERCENTILE Average.xls or Average.xlsx
PERCENTILE.INC or  
PERCENTILE.EXC

Average.xlsx

PERCENTRANK Average.xls or Average.xlsx
PERCENTRANK.INC or  
PERCENTRANK.EXC

Average.xlsx

QUARTILE Average.xls or Average.xlsx
QUARTILE.INC or QUARTILE.EXC Average.xlsx
RANK Count.xls or Count.xlsx
RANK.EQ Count.xlsx
RANK.AVG Count.xlsx
LINEST Regression.xls or Regression.xlsx
LOGEST Regression.xls or Regression.xlsx
FORECAST Regression.xls or Regression.xlsx
SKEW Symmetry.xls or Symmetry.xlsx
STDEV or STDEV.S Variance.xls or Variance.xlsx
STDEVA Variance.xlsx
STDEVP or STDEV.P Variance.xls or Variance.xlsx
STDEVPA Variance.xlsx
STANDARDIZE Probability.xls or Probability.xlsx
SLOPE Regression.xls or Regression.xlsx
STEYX Probability.xls or Probability.xlsx
DEVSQ Regression.xls or Regression.xlsx
TINV or T.INV or T.INV.2T Probability.xls or Probability.xlsx
TREND Regression.xls or Regression.xlsx
TTEST or T.TEST Probability.xls or Probability.xlsx
TDIST or T.DIST or T.DIST.2T Probability.xls or Probability.xlsx
T.DIST.RT Probability.xlsx
VAR or VAR.S Variance.xls or Variance.xlsx
VARA Variance.xls or Variance.xlsx
VARP or VAR.P Variance.xls or Variance.xlsx
VARPA Variance.xls or Variance.xlsx
GROWTH Regression.xls or Regression.xlsx
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PERMUT Probability.xls or Probability.xlsx
PROB Probability.xls or Probability.xlsx
WEIBULL or WEIBULL.DIST Probability.xls or Probability.xlsx
COUNTIF Count.xls or Count.xlsx
COUNTIFS Count.xlsx

Chapter13 Raw data DBFUNCTION_empty.xls or  
DBFUNCTION_empty.xlsx 

DCOUNT DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DCOUNTA DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DGET DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DMAX or DMIN DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DAVERAGE DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DPPRODUCT DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DSTDEV DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DSTDEVP DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DSUM DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DVAR DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

DVARP DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

GETPIVOTDATA DBFUNCTION2.xls or  
DBFUNCTION2.xlsx

Chapter14 Cube Test.cub Use the offline cube file to test the 
cube functions without Microsoft  
Analysis Services

offline cubeTest.xlsx This workbook contains the example 
applications for the cube functions

offLine.odc Use the office data connection file 
to access data through workbook 
connections

offLine.oqy Use the office data connection file to 
access data through Microsoft Query
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Chapter15 AMORDEGRC Depreciation Calculation.xls or  
Depreciation Calculation.xlsx 

AMORLINC Depreciation Calculation.xls or  
Depreciation Calculation.xlsx

ACCRINT Simple Interest Calculation.xls or  
Simple Interest Calculation.xlsx

ACCRINTM Simple Interest Calculation.xls or  
Simple Interest Calculation.xlsx

Bill of Exchange Simple Interest Calculation.xls or  
Simple Interest Calculation.xlsx

PV Compound Interest Calculation.xls or 
Compound Interest Calculation.xlsx; 
Repayment Calculation.xls or Repay-
ment Calculation.xlsx; Annuity Calcula-
tion.xls or Annuity Calculation.xlsx

SYD Depreciation Calculation.xls or  
Depreciation Calculation.xlsx

Treasury Bonds Simple Interest Calculation.xls or  
Simple Interest Calculation.xlsx

DURATION Price Calculation.xls or  
Price Calculation.xlsx

EFFECT Compound Interest Calculation.xls or 
Compound Interest Calculation.xlsx

DDB Depreciation Calculation.xls or  
Depreciation Calculation.xlsx

DB Depreciation Calculation.xls or  
Depreciation Calculation.xlsx

IRR Investment Calculation.xls or  
Investment Calculation.xlsx

ISPMT Simple Interest Calculation.xls or  
Simple Interest Calculation.xlsx

PRICE Price Calculation.xls or  
Price Calculation.xlsx

SLN Depreciation Calculation.xls or  
Depreciation Calculation.xlsx

MDURATION Price Calculation.xls or  
Price Calculation.xlsx

NPV Investment Calculation.xls or  
Investment Calculation.xlsx
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DOLLARFR Other.xls or Other.xlsx
DOLLARDE Other.xls or Other.xlsx
MIRR Investment Calculation.xls or  

Investment Calculation.xlsx
YIELD Price Calculation.xls or  

Price Calculation.xlsx
YIELDMAT Simple Interest Calculation.xls or  

Simple Interest Calculation.xlsx
PMT Annuity Calculation.xls or  

Annuity Calculation.xlsx
TBILL Simple Interest Calculation.xls or  

Simple Interest Calculation.xlsx
ODDFPRICE Price Calculation.xls or  

Price Calculation.xlsx
ODDFYIELD Price Calculation.xls or  

Price Calculation.xlsx
ODDLPRICE Simple Interest Calculation.xls or  

Simple Interest Calculation.xlsx
ODDLYIELD Simple Interest Calculation.xls or  

Simple Interest Calculation.xlsx
VDB Found in Depreciation Calculation.xls or 

Depreciation Calculation.xlsx
XIRR Investment Calculation.xls or  

Investment Calculation.xlsx
XNPV Investment Calculation.xls or  

Investment Calculation.xlsx
RATE Compound Interest Calculation.xls or 

Compound Interest Calculation.xlsx; 
Annuity Calculation.xls or Annuity
Calculation.xlsx

PRICE and YIELD Price Calculation.xls or  
Price Calculation.xlsx

FV Compound Interest Calculation.xls or 
Compound Interest Calculation.xlsx; 
Annuity Calculation.xls or Annuity Cal-
culation.xlsx; Repayment Calculation.xls 
or Repayment Calculation.xlsx

FVSCHEDULE Compound Interest Calculation.xls or 
Compound Interest Calculation.xlsx
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NPER Compound Interest Calculation.xls or 
Compound Interest Calculation.xlsx; 
Annuity Calculation.xls or Annuity  
Calculation.xlsx; or Repayment Calcula-
tion.xls or Repayment Calculation.xlsx

Chapter16 AGGREGATE.xlsx Chapter16 folder
ARRAY_FUNCTION Chapter16.xls or Chapter16.xlsx
ARRAY_FUNCTION2 Chapter16.xls or Chapter16.xlsx
ATAN2 Chapter16.xls or Chapter16.xlsx
COMBIN Chapter16.xls or Chapter16.xlsx
Data&Chart and Example ACosH.xls or ACosH.xlsx
Data&Chart ASinH.xls or ASinH.xlsx
Data&Chart ATanH.xls or ATanH.xlsx
Data&Chart and Example CosH.xls or CosH.xlsx
Data&Chart and Distribution SinH.xls or SinH.xlsx
Data&Chart and Water waves TanH.xls or TanH.xlsx
EXP Chapter16.xls or Chapter16.xlsx
EXP_LOG_LN Chapter16.xls or Chapter16.xlsx
FACT Chapter16.xls or Chapter16.xlsx
FLOOR Chapter16.xls or Chapter16.xlsx
GCD_LCM Chapter16.xls or Chapter16.xlsx
LOG_LN Chapter16.xls or Chapter16.xlsx
MOD Chapter16.xls or Chapter16.xlsx
POWER Chapter16.xls or Chapter16.xlsx
PRODUCT Chapter16.xls or Chapter16.xlsx
PRODUCT_SUM Chapter16.xls or Chapter16.xlsx
RAND Chapter16.xls or Chapter16.xlsx
ROMAN Chapter16.xls or Chapter16.xlsx
ROUND Chapter16.xls or Chapter16.xlsx
ROUNDUP Chapter16.xls or Chapter16.xlsx
Seriessum Seriessum.xls or Seriessum.xlsx
SIGN Chapter16.xls or Chapter16.xlsx
SIN_COS Chapter16.xls or Chapter16.xlsx
SQRT Chapter16.xls or Chapter16.xlsx
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SUBTOTAL Chapter16.xls or Chapter16.xlsx
SUBTOTAL2 Chapter16.xls or Chapter16.xlsx
SUMIF Chapter16.xls or Chapter16.xlsx
SUMIFS Chapter16.xls or Chapter16.xlsx
SUMIFS2 Chapter16.xls or Chapter16.xlsx
SUMPRODUCT Chapter16.xls or Chapter16.xlsx
SUMXY Chapter16.xls or Chapter16.xlsx
trigon Chapter16.xls or Chapter16.xlsx

Chapter 17 Binary Numbers.xls or Numbers.xlsx
Decimal Numbers.xls or Numbers.xlsx
Hexadecimal Numbers.xls or Numbers.xlsx
Octal Numbers.xls or Numbers.xlsx
Sheet1 Convert.xls or Convert.xlsx
Complex Complex.xls or Complex.xlsm
BESSEL I and Chart Bessel_I.xls or Bessel_I.xlsx
BESSEL J and Chart Bessel_J.xls or Bessel_J.xlsx
Bessel K and Chart Bessel_K.xls or Bessel_K.xlsx
Bessel Y and Chart Bessel_Y.xls or Bessel_Y.xlsx
Data and Chart Gauss.xls or Gauss.xlsx
Sheet1 Delta.xls or Delta.xlsx
Longjump GESTEP.xls or GESTEP.xlsx
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We have tried to bring you substantiated descriptions, practical examples, and solutions 
in all chapters, and to present the wide range of material without errors. Whether we have 
succeeded in fulfilling our own requirements is up to you to decide. We are realists and 
know that a book like this can always be improved in spite of all our efforts. We are there-
fore looking forward to receiving your critiques, suggestions, and notes.

Support and Feedback
The following sections provide information on errata, book support, feedback, and contact 
information.

Errata & Support

We’ve made every effort to ensure the accuracy of this book and its companion content. 
Any errors that have been reported since this book was published are listed on our Micro-
soft Press site: 

http://www.microsoftpressstore.com/title/ 9780735658028

If you find an error that is not already listed, you can report it to us through the  
same page.

If you need additional support, email Microsoft Press Book Support at  
msinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the 
addresses above.

We Want to Hear from You

At Microsoft Press, your satisfaction is our top priority and your feedback our most valuable 
asset. Please tell us what you think of this book at

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in Touch

Let’s keep the conversation going! We’re on Twitter: http://twitter.com/MicrosoftPress

http://www.microsoftpressstore.com/title/ 9780735658028
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This chapter introduces Microsoft Excel and its functions. There are more practical 
examples with detailed function descriptions in Chapters 7 to 17 of this book. 

First you will become familiar with Excel 2010, because there have been some nota-
ble changes since Excel 2007. Even if you are already using Excel 2010, you should be able 
to find some interesting points and suggestions.

Introducing the New Functions in Excel 2010
Microsoft Excel 2010 includes several new functions, many of which are introduced in the 
following Profit Margin example. Calculating a profit margin is important for price calcula-
tions and for planning operating results. By calculating the profit margin, you can build a 
decision-oriented cost accounting system. 

Scenario and Goals
The Contoso, Ltd. company wants to evaluate and analyze its profit margins, focusing on 
overall percentages and variances. After you complete this example, you should be able to 
perform the following actions in Excel:

●	 Automatically fill in a month series and create your own fill styles

●	 Enter formulas

●	 Work with tables and style sheets
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●	 Format cells

●	 Add and format graphics and charts

●	 Create a PivotTable and PivotChart

Sample Files
Use the Profit margin, Namerows, and Table profit margin worksheets in the Excel_
Example.xls or Excel_Example.xlsx sample file. The sample files are found in the 
Chapter01 folder. For more information about the sample files, see the section titled 
“Using the Sample Files” on page xxiii.

The New Way to Work with Data, Formulas, and 
Functions

In this section, you will learn how to effectively work with Excel 2010 and explore the new 
possibilities.

Creating the Month Data Series

To quickly create a list of all months of the year, perform the following steps:

	 1.	 Select File/New and click Create to open an empty Excel workbook.

	 2.	 Enter the following text in columns A2 through E2 (see Figure 1-1):

m	 Month (A2)

m	 Purchase (B2)

m	 Sales (C2)

m	 Profit margin (D2)

Figure 1-1  Naming the table columns.
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	 3.	 To enter the names of the months, you will use the fill feature. Start by entering 
January in cell A3.

	 4.	 Select cell A3 and point to the small square in the lower-right corner of the selected 
cell, the fill handle (see Figure 1-2). The mouse pointer changes to a black crosshair 
pointer. 

Figure 1-2  The fill handle for extending the data series.

	 5.	 Drag the crosshairs into cell A14. While you drag the crosshairs down, you will see 
the names of the months in the preview (see Figure 1-3).

Figure 1-3  The months are added by using the fill handle.

	 6.	 Release the mouse button in cell A14 to display all months from January through 
December (see Figure 1-4).
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Figure 1-4  The names of the months are automatically filled in.

Creating an Individual Data Series

This feature can be used to fill rows or columns; it works for weekdays, months, and dates. 
To fill a number series, fill in the first two numbers in the sequence manually, select the two 
completed cells, and then drag the fill handle. The function can also be useful if you want 
to create your own data or AutoFill series. For example, if you don’t want to enter a list of 
sales managers over and over again, you can define your own AutoFill list:

	 1.	 Click the last sheet tab at the bottom of the workbook, which is the one with the 
new sheet symbol, to open a new sheet. Alternatively, you can press the Ctrl+F11  
key combination.

	 2.	 Enter Sales manager in a free cell.

	 3.	 Enter the names of the sales managers in the cells below the Sales manager title (see 
Figure 1-5).

Figure 1-5  Creating a custom data series.
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	 4.	 Select the range containing the names.

	 5.	 Click the File tab and select Options (see Figure 1-6).

Figure 1-6  Selecting Excel options.

	 6.	 In the Excel Options dialog box, select the Advanced category and click Edit Custom 
Lists in the General section (see Figure 1-7).

Figure 1-7 Opening frequently used lists.
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Tip
In Excel 2003, the Excel options are located in the Custom menu. In Excel 2007, 
you can access the options from the Microsoft Office button, and in Excel 2010 
they are on the File tab. Click Excel Options or Options, respectively.

	 7.	 Make sure that the cell reference for the selected list is displayed in the Import List 
From Cells field, and click Import (see Figure 1-8).

Figure 1-8  Specifying the cell range to be imported.

The elements in the selected list are added to the List Entries field (see Figure 1-9).

Figure 1-9  The list entries are added.

	 8.	 Click OK twice.
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Now you have to enter only the name of one sales manager in a cell and drag the fill han-
dle in the desired direction to generate the list of the sales managers on any spreadsheet. 
The series is created automatically.

This strategy gives you almost unlimited possibilities for creating a data series.

Entering Test Data Fast
Now let’s return to the scenario described earlier in the chapter, in the section titled “Sce-
nario and Goals.” To complete the table with sales and purchase values, you need a set of 
sample data so that you can create and check the example. A convenient way to do this is 
to generate a set of random data by using the RANDBETWEEN() function.

	 1.	 Select cell B3 in the Excel sheet that contains the table you created previously.

	 2.	 Enter the following function: =RANDBETWEEN(1000,500000). The values 1000 and 
500000 indicate the minimum and maximum values and are divided by the comma 
(see Figure 1-10).

Figure 1-10 Working with formulas.

	 3.	 Press the Enter key. A random number from 1,000 through 500,000 appears in the 
cell (see Figure 1-11).

Figure 1-11  The RANDBETWEEN function calculates a random value.

	 4.	 Select the cell and double-click the fill handle. The Purchase column is automatically 
filled through December (see Figure 1-12).
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Figure 1-12  Values are added within seconds.

	 5.	 Edit the table however you want.

Converting Formula Results into Fixed Values
To ensure that the random values in the Purchase and Sales columns don’t change, create a 
permanent copy of the entries by performing the following steps:

	 1.	 Select the cells in the Purchase column from January through December.

	 2.	 Point to the right edge of the selected column. The pointer changes into an arrow.

	 3.	 Click the right mouse button and drag the selection to the right and back. The 
movement is illustrated by a dashed line (see Figure 1-13).

Figure 1-13  The selected values are moved to the right and back.
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Tip  Use the Paste Values icon
If you are working with Excel 2010, there is an easier way to copy the values. 
Copy the values in the Purchase column, and then paste them by opening the 
Paste menu and clicking the Paste Values icon (see Figure 1-14).

Figure 1-14  The Paste Values icon.

	 4.	 When the selection is back in the original position, release the mouse button and 
select Copy Here As Values Only in the shortcut menu (see Figure 1-15).

Figure 1-15  Converting numbers into fixed values.

The random values in the column are now fixed values and not formula-generated.
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	 5.	 Repeat these steps and those in the section titled “Entering Test Data Fast” for the 
values in the Sales column, after you generate a fixed set of random values there, too.

Formatting Numeric Values
To format the numeric values in the Purchase and Sales columns as currency values, per-
form the following steps:

	 1.	 Select the cells B3 to C14.

	 2.	 Click the Accounting Number Format button in the Number group on the Home Tab 
(see Figure 1-16).

Figure 1-16  Formatting numbers as dollar values.

The selected values are automatically displayed as decimal numbers with two decimal 
places, in the currency format (see Figure 1-17).

Figure 1-17  The numbers are displayed as dollar amounts.
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Calculating Profit Margin
To calculate the profit margin, do the following:

	 1.	 Click in cell D3 and subtract the Purchase amount from the Sales amount. To do this, 
enter an equal sign (=) in cell D3, click in cell C3, enter a minus sign (–) and then click 
in cell B3 (see Figure 1-18).

Figure 1-18  Subtracting values.

	 2.	 Press the Enter key.

	 3.	 Double-click the fill handle to calculate the profit margin through December (see 
Figure 1-19).

Figure 1-19  The profit margin is calculated for all months.
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Formatting Data as a Table
In Excel 2007 and Excel 2010, a selection of preset table formats can be readily accessed 
from the ribbon. 

	 1.	 Select the cells containing the entire table (A2:D14).

	 2.	 On the Home tab, click the Format As Table button in the Style group and select one 
of the table layouts shown in Figure 1-20.

Figure 1-20  Table formats in Excel 2007 and Excel 2010.

	 3.	 The Create Table dialog box shows the range to be formatted (see Figure 1-21). 
Click OK.

Figure 1-21  Confirming the table range to be formatted.
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The table is formatted in the selected layout (see Figure 1-22).

Figure 1-22  Formatting tables in only a few steps.

After you have formatted the data as a table, you can use the filter options that have been 
placed in the table header.

INSIDE OUT  Format data as a table for added functionality

Formatting data as a table provides a convenient way to arrange the information neatly 
and concisely and also provides access to additional table features.

Calculating Profit Margin as a Percentage
This section explains how to calculate the profit margin as a percentage for the full year. To 
do this, perform the following steps:

	 1.	 Select cell D15, which is below the profit margin for December.

	 2.	 On the Home tab, in the Editing group, click the AutoSum button (see Figure 1-23).
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Figure 1-23  Calculating the sum with one mouse click.

The sum is automatically calculated and displayed in the Profit Margin column (see 
Figure 1-24).

Figure 1-24  Simplified calculation options with table formatting.
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Tip  Choose calculations options
Did you notice the arrow to the right of the sum field? Click the arrow to 	
open a menu, select one of the different options, and view the result (see 
Figure 1-25).

Figure 1-25  The calculation options for table ranges.

	 3.	 Create the profit margin percentage in the column next to the Profit Margin column. 
When you enter the text in column E, the table formatting is automatically extended 
to the additional column (see Figure 1-26).

Figure 1-26  Adding columns to the table.
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	 4.	 Press the Enter key. The column is added to the table automatically and inherits the 
table layout (see Figure 1-27).

Figure 1-27  New columns are automatically adjusted to the table layout.

	 5.	 To calculate the profit margin as a percentage for January, click cell E3 (Profit Margin 
(%) column, January row).

	 6.	 The formula is ”the profit margin of January divided by the total profit margin.” To 
enter this in the cell, click cell D3 after the equal sign, type a forward slash, and then 
click cell D15 (see Figure 1-28).

Figure 1-28  In Excel 2007 and Excel 2010, formulas include table values.

	 7.	 Press the Enter key to confirm. Because the data has been formatted as a table, the 
formula entered is automatically applied to all cells in the Profit Margin (%) column 
(see Figure 1-29).
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Figure 1-29  The formula is applied to all cells in the column.

	 8.	 Select the numeric values in the Profit Margin (%) column, and click the Percent Style 
button in the Number group on the Home Tab (see Figure 1-30).

Figure 1-30  Numbers are displayed as percentages.

The values are now displayed as percentages (see Figure 1-31).

Figure 1-31  The profit margins as percentages.
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Applying Conditional Formatting
To make data easier to interpret, use the conditional formatting feature to automatically 
format the data. With conditional formats, values are selected if they meet certain criteria, 
and the cell range is formatted accordingly. Conditional formats visually highlight the distri-
bution and variation of data.

With regard to our example, the condition could be “Format in green all cells in the Profit 
Margin column that contain a value of at least $200,000.” To enter this format, perform the 
following steps:

	 1.	 Select the cell range in the Profit Margin column.

	 2.	 Click the Conditional Formatting button in the Style group on the Home tab, and 
then click New Rule (see Figure 1-32).

Figure 1-32  Creating a new rule.

	 3.	 In the New Formatting Rule dialog box, under Select A Rule Type, select Format Only 
Cells That Contain.

	 4.	 Specify the settings in the Edit The Rule Description pane. Select Cell Value and 
Greater Than Or Equal To in the list boxes.

	 5.	 Enter the value 200000 in the third field (see Figure 1-33).
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Figure 1-33  Defining the formatting rule.

	 6.	 Click the Format button.

	 7.	 Click the Fill tab of the Format Cells dialog box, and select a background color (see 
Figure 1-34).

Figure 1-34  The condition is displayed in color.
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	 8.	 Click OK twice to confirm your selection. The values in the Profit margin column are 
displayed in the color you selected if the condition is met (see Figure 1-35).

Figure 1-35  Values meeting the condition have a green background.

You can use conditional formatting to automatically display the values in your table in dif-
ferent colors to give them significant visual impact.

You can also use other color fill options or an icon set to format cells. Conditions can apply 
to text, numeric, date, or time values, as well as to values that fall below or above the 
average.

Data bars are also a quick way to visually highlight values in tables (see Figure 1-36).

Figure 1-36  Using formats to highlight numeric values.

There are many different options to choose from.
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Tip  Apply conditional formats to highlight data
In Excel 2007 and Excel 2010, conditional formats have improved significantly (see 
Figure 1-37). Now you can add not only colors but also arrows, traffic lights, and other 
icons. This functionality is also referred to as KPI (Key Performance Indicators).

Figure 1-37  New elements for conditional formats in Excel 2007 and Excel 2010.

Creating Meaningful Charts
Sometimes it is useful to display data in a chart instead of in a table. In Excel 2007 and Excel 
2010, the options for creating bar charts, pie charts, and other charts have been enhanced.

Creating a Column Chart

To convert our example table into a simple but informative column chart, perform the fol-
lowing steps:

	 1.	 Select the table cells starting from Month to the profit margin December (see 
Figure 1-38).



Chapter 1

22	 Chapter 1  Solving Problems with Functions

Figure 1-38  Selecting a value to create a chart.

	 2.	 On the Insert tab in the Chart group, click the Column button and select the first 
chart under 2D Column (see Figure 1-39).

Figure 1-39  Selecting the chart format.
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The chart is immediately displayed on your Excel sheet (see Figure 1-40).

Figure 1-40  The data displayed as a chart.

In the same way you created a column chart, you can create a 2D, 3D, or line chart (see Fig-
ure 1-41). To do this, select a chart format by clicking the Line button to open the menu.

Figure 1-41  Another view of the chart.
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Creating a Pie Chart

To display the values in the Profit Margin column by month, you can use a pie chart. Do the 
following:

	 1.	 Select the cells containing values in the Months and Profit Margin columns. To select 
only these two columns, first select the Months column. Then press the Ctrl key and 
select the Profit Margin column. Both columns are selected (see Figure 1-42).

Figure 1-42  Selecting only certain columns of the list.

	 2.	 Click the Pie button to open the menu, and select the first chart type under 3D Pie 
(see Figure 1-43).

Figure 1-43  Selecting a pie chart.
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The pie chart is displayed immediately (see Figure 1-44).

Figure 1-44  The pie chart shows the profit margin.

Formatting a Chart

Excel 2010 provides many formatting options you can use to emphasize values in pie 
charts.

Do the following:

	 1.	 Click the frame of the chart.

The Chart Tools contextual tab opens. On this tab, you can choose between the avail-
able formatting options (see Figure 1-45).

Figure 1-45  The Chart Tools tab in Excel 2010 for editing charts.
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	 2.	 With these tools, you can select any of the format options. For example, click 
Layout 6 in the Chart Layouts section (see Figure 1-46).

Figure 1-46  Changing the chart layout.

Layout 6 displays your pie chart with percentages, or values (see Figure 1-47).

Figure 1-47  The settings of the selected chart layout are applied.

	 3.	 With the chart formats, you can also adjust the chart colors. Just click one of the 
available formats (see Figure 1-48).

Figure 1-48  Using chart formats to adjust the color.

The color of the chart changes according to your selection (see Figure 1-49).
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Figure 1-49  The selected chart colors are applied.

	 4.	 In Excel 2010—as in Excel 2007 and Excel 2003—more chart format options are 
available in the shortcut menu of the selected chart. Right-click the chart to open 
the menu, and then select Format Data Labels or Format Data Series to change the 
format of your chart (see Figure 1-50).

Figure 1-50  Additional formatting options.
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In Excel 2010, working with charts is a lot easier. The options for editing and formatting are 
more extensive, and fully formatted charts can be created with just a few clicks.

INSIDE OUT  Use sparklines to graphically represent values

Check out the new sparklines in Excel 2010. These “word graphics” illustrate values by 
using miniature line, bar, or profit-and-loss charts. Sparklines illustrate numeric values 
so that the values can be interpreted more easily (see Figure 1-51).

Figure 1-51  Values illustrated by the new sparklines.

Working with PivotTables
PivotTables help you arrange and consolidate data into well-defined tables. With a Pivot-
Table, you can easily generate cross-tabulations and analyze information by rotating and 
moving column and row selections and by filtering. The original data remains unchanged, 
and the PivotTable is quickly generated even with large amounts of data. In Excel 2007 and 
Excel 2010, PivotTable data can also easily be displayed as a PivotChart.
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Tip
A PivotTable is useful for quickly obtaining summary information from long lists or 
large amounts of data.

Creating a PivotTable 

Sample Files
Use the Basic data worksheet in the Excel_Pivot_Data.xls or Excel_Pivot_Data.xlsx sam-
ple file. The sample files are found in the Chapter01 folder. For more information about 
the sample files, see the section titled “Using the Sample Files” on page xxiii.

To create a PivotTable, perform the following steps:

	 1.	 Open the Excel_Pivot_Data.xlsx file from the sample files.

	 2.	 In the table, select the cell range for which you want to create the PivotTable. In this 
case, select cell A1 (Customer Name) through cell J100 (Total Price), or select the 
entire table by pressing Ctrl+A from anywhere within the table.

	 3.	 On the Insert tab, in the Table group, click the arrow on the PivotTable button and 
select PivotTable (see Figure 1-52).

Figure 1-52  Creating a PivotTable.
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Tip  Find Pivot functions on the Insert tab
In Excel 2003, the Pivot functions were located on the File menu. In Excel 2007 
and Excel 2010, you can open the Pivot functions by clicking a button on the 
Insert tab. The functions open in a separate tool window as soon as you start 	
creating a PivotTable.

Because you have already selected the data, the PivotTable range is displayed in the 
Select Table Or Range box in the PivotTable dialog box. 

	 4.	 Select an option under Choose Where You Want The PivotTable Report To Be Placed. 
Selecting the New Worksheet option is recommended (see Figure 1-53).

	 5.	 Click OK. The PivotTable framework is displayed.

Figure 1-53  Choosing where to place the PivotTable.
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An empty PivotTable report is added, in this case in a new worksheet, and the PivotTable 
field list is displayed. In this list, you can select fields, create a layout, and change the Pivot-
Table report.

You can also use the PivotTable tools on the PivotTable Tool contextual tab, which you can 
access from the ribbon (see Figure 1-54).

Figure 1-54  The PivotTable layout.

Using a PivotTable 

The following example illustrates the functionality of a PivotTable. Assume that you want 
to find out in which country the most orders for gloves are placed. For this you need the 
PivotTable fields Country, Product Category, and Order Quantity.
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Follow these steps:

	 1.	 Select the Country, Product Category, and Order Quantity check boxes in the 
PivotTable field list.

After you have enabled the fields, the associated data are automatically positioned 
in the default range of the layout, but you can move the fields to any position (see 
Figure 1-55).

Figure 1-55  The fields in the standard report.
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	 2.	 Because you want to view the order quantity for gloves per country, you should 
move the Product Category column into the Report Filter area. This will allow you to 
filter by country. Drag the Product Category field into the Report Filter area within 
the PivotTable field list (see Figure 1-56).

Figure 1-56 Moving fields by dragging.

As soon as you release the mouse button, the data is arranged in the PivotTable (see 
Figure 1-57).

Figure 1-57  The newly arranged fields.
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	 3.	 In the (All) list, select Gloves and click OK (see Figure 1-58).

Figure 1-58  Select Gloves from the list so that only the result for gloves will be displayed.

Only the order quantities for gloves in the individual countries are displayed (see Fig-
ure 1-59). Canada is the frontrunner!

Figure 1-59  Getting meaningful results with only a few clicks.

Note
Don’t worry if a report is not what you were expecting. With Excel, you can try various 
options to see how the data looks in different formats by rearranging the data, moving 
data, or even starting again.
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Using PivotCharts: Graphical Pivot
The new user interface also makes it easier to create PivotCharts. All filter enhancements for 
PivotTables are also available for PivotCharts. There are special PivotChart tools and short-
cut menus you can use to create a PivotChart to analyze the data within a chart.

You can change the layout and the format of charts or the chart elements in the same way 
you make changes for Pivot Tables. Unlike in previous Excel versions, in Excel 2007 and 
Excel 2010, the chart format is maintained if you change the PivotChart.

Creating a PivotChart

Creating a chart for a PivotTable takes only seconds. Use the previous PivotTable example 
to practice. Do the following:

	 1.	 Click in the PivotTable, and select the PivotTable Tools contextual tab above the 
default tab (see Figure 1-60).

Figure 1-60 Working with PivotTable tools.

	 2.	 In the Tools group, click the PivotChart button (see Figure 1-61). The Insert Chart 
dialog box opens. The first layout under Column is selected (see Figure 1-62).

Figure 1-61  Creating a chart from PivotTable data.
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Figure 1-62  Selecting the chart format.

	 3.	 Keep this setting and click OK. The chart and a PivotChart filter range are displayed 
(see Figure 1-63).

Figure 1-63  The PivotChart is created.

	 4.	 As soon as you change the filter, the chart also changes. In the Country list, select 
Germany and click OK (see Figure 1-64).
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Figure 1-64  Selecting a filter.

The chart changes automatically, and the corresponding values are displayed (see 
Figure 1-65).

Figure 1-65  The chart changes depending on the Pivot data.
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Changing the Original Data

PivotTables and PivotCharts change dynamically: If a value changes in the original data, the 
PivotTable and the associated chart also change. Try it out:

	 1.	 In the original data, increase the order quantity for gloves in Germany in any row (see 
Figure 1-66).

Figure 1-66  Changing the original data.

	 2.	 Go back to the PivotTable and open the PivotTable Tools contextual tab.

	 3.	 On the Analyze tab, in the Data group, click the Refresh button (see Figure 1-67).

Figure 1-67  Applying changes to the original data by clicking Refresh.

The PivotTable as well as the PivotChart are automatically updated (see Figure 1-68).

Figure 1-68  The values are updated.
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Note
You can change additional settings for PivotCharts: Select a chart element and open 
the shortcut menu (see Figure 1-69).

Figure 1-69  The shortcut menu allows quick access to the settings.
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Cube functions were introduced in Microsoft Excel 2007. They are used with con-
nections to external SQL data sources and provide analysis tools. Data cubes are 
multidimensional sets of data that can be stored in a spreadsheet, providing a 

means to summarize information from the raw data source. A cube is different from queries 
in Microsoft Access or Microsoft SQL Server because the data in a cube is already grouped 
in hierarchies, and calculated measures are saved in the cube. This offers two advantages to 
the user: Summary information is readily available, and most of the heavy-duty calculations 
are performed on the server. The user does not have to spend much time consolidating the 
data in Excel. However, you cannot use calculated fields or elements for a PivotTable.

To use cube functions, you must be working with data that is available in one of these two 
forms:

●	 Through a connection to a SQL Server Analysis Services data source

●	 In an offline cube in the user’s local file system

These conditions limit the usefulness of cube functions. So that you will be able to work 
through some examples, the sample files accompanying this book include offline cube 
and data connection files for the example outlined in Chapter 2, “Using Functions and 
PowerPivot.”

Note
You can create and change an offline cube (a file with the extension .cub) in Excel.

First, you must establish a connection to the Analysis Services by using Microsoft Query 
(on the Data Tab, Query External Data/From Other Source/From Microsoft Query), or 
by using the Data Connection Assistant (on the Insert Tab, select PivotTable/Use External 
Data Source). Then click the OLAP Tools button, as shown in Figure 14-1, to open the 
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Offline OLAP Settings dialog box. (OLAP stands for online analytical processing.) Click 
the Create Offline Data File button to create the cube, and follow the step-by-step 
instructions.

Figure 14-1  Creating an offline cube.

However, you will have to change the sample data connection files (they have either 
the extension .odc for a workbook connection, or .oqy for Microsoft Query) because the 
path to a database must be the full path. Use Windows Notepad to change the paths as 
follows:

Data Source='X:\Documents\Chp14\Book\CubeTest.cub'; 
   Location='X:\Documents\Chp14\Book\CubeTest.cub';

Sample Files
Use the offline cubeTest.xlsx sample file. This sample file and the additional files are 
found in the Chapter14 folder. For more information about the sample files, see the 
section titled “Using the Sample Files” on page xxiii.

The prepared sample workbook serves as a guide. To avoid unnecessary errors when 
modifying this sample, perform the following steps to create your own workbook:

	 1.	 On the Insert tab, select PivotTable/Use External Data Source. (You can search for 
additional elements and use the existing data connection files.)

	 2.	 Create the layout and include the content from the data source. 

	 3.	 Use the cube functions.
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When you open a workbook with data connections and use the default Excel settings, you 
have to explicitly allow these connections (click the Enable Content button, as shown in 
Figure 14-2). When you activate a document in Excel 2010, the document is trusted and 
you don’t have to confirm the activation again until the trusted document is reset in the 
Trust Center.

Figure 14-2  The security warning that is shown when Excel is accessing external data.

Note
If you select Convert To Formulas from the OLAP Tools menu (see Figure 14-1, shown 
earlier in this chapter), Excel converts part of the PivotTable or the entire PivotTable 
into an unformatted table with the same content as the PivotTable. The advantage of 
this is that the entire layout (columns and rows) is fixed. You can also include filters.

If you are familiar with formulas, you can create individual structures similar to Pivot-
Tables that allow for flexible data evaluation.

The descriptions of the functions throughout the rest of this chapter refer to the example in 
Chapter 2. The example uses two store groups named North and South, which sell sweets 
(chocolate and cookies) from the years 2008 through 2011. Each store group consists of 
two stores. Table 14-1 describes the functions.
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Table 14-1  Overview of the Cube Functions

Function Description
CUBEKPIMEMBER() Returns the requested property for a Key Performance 

Indicator (KPI) of a cube
CUBEMEMBER() Returns a member of the cube
CUBEMEMBERPROPERTY() Returns the requested property (attribute) for a cube 

member
CUBERANKEDMEMBER() Returns the n-th ranked member of a set
CUBESET() Defines a set of members to create a subcube 
CUBESETCOUNT() Returns the number of items in a set
CUBEVALUE() Returns the aggregated value from a data cube

CUBEKPIMEMBER()
Syntax  CUBEKPIMEMBER(connection,kpi_name,kpi_property,caption)

Definition  This function returns a Key Performance Indicator (KPI) property and displays 
the KPI name in the cell.

Arguments

●	 connection (required)  A string with the name of the workbook connection to the 
cube. After you enter the first quotation mark, the existing context-sensitive data 
connections are displayed (see Figure 14-4, shown later in this chapter in the descrip-
tion of CUBEMEMBER()).

●	 kpi_name (required)  Specifies the name of the KPI in the cube.

●	 kpi_property (required)  A KPI consists of several components that are specified by 
using an integer (see Table 14-2).

Table 14-2  Integers for the Third Argument of the CUBEKPIMEMBER() Function

Integer MDX expression Description

1 [KPIValue] Actual value
2 [KPIGoal] Target value
3 [KPIStatus] State of the KPI at a specific moment in 

time
4 [KPITrend] Measure of the value over time
5 [KPIWeight] Relative importance assigned to the KPI
6 [KPICurrentTimeMember] Temporal context for the KPI
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●	 caption (optional)  A string displayed in the cell instead of the caption of the KPI 
components in the cube.

Background

Note
In the cell containing the function, the message #GETTING_DATA temporarily appears 
while the data is being queried.

Error values and messages provide information about incorrect or missing entries:

●	 If the connection name is not a valid workbook connection, the CUBEKPIMEMBER() 
function returns the #NAME? error.

●	 If the OLAP server (or the offline cube) is not available, you get an error message. The 
content of the affected cell doesn't change.

●	 CUBEKPIMEMBER() returns the #N/A error value when kpi_name or kpi_property is 
invalid.

●	 CUBEKPIMEMBER() might return the #N/A error when the connection to the data 
source is interrupted and cannot be re-established

You can combine CUBEKPIMEMBER() with CUBEVALUE(). Specify CUBEKPIMEMBER() as the 
second argument or reference for CUBEVALUE().

Example  In this example, a KPI named average is saved in the cube. This cube calculates 
the average of the sales and the total number of sales as integers. Both values are also 
saved as measures in the cube but cannot be used to calculate fields in the PivotTable. The 
target value (goal) is $1,500. Figure 14-3 shows the example for cookies.

Figure 14-3  The KPI average.
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The formula

=CUBEKPIMEMBER("offline","average",1)

displays the word average. The formula

=CUBEVALUE("offline",CUBEKPIMEMBER("offline","average",1))

returns 1453 (the rounded average of all sales). In the second formula, you can enter a ref-
erence to the cell containing the first formula as the second argument. To get the target 
value of the average, use the formula

=CUBEVALUE("offline",CUBEKPIMEMBER("offline","average",2))

The value of 2 in the last argument is important, because it indicates, in this case, the target 
value.

You can use the cell containing the formula to create cell captions. The real content of the 
cell is more informative, as shown by using the CUBEVALUE() function.

See Also  All other cube functions, GETPIVOTDATA()

CUBEMEMBER()
Syntax  CUBEMEMBER(connection,member_expression,caption)

Definition  This function returns a member (cell) from a cube. Use CUBEMEMBER() to 
validate that the member exists and to pass the member to other functions through a cell 
reference.

Arguments

●	 connection (required)  The text string name of the workbook connection to the 
cube, in quotation marks. When you are entering the connection, after you type the 
first quotation mark, existing context-sensitive data connections are displayed (see 
Figure 14-4).

Figure 14-4  Context sensitivity helps you enter formulas.
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●	 member_expression (required)  Defines the position of a member in the cube based 
on a multidimensional expression (MDX). The expression can be entered directly or it 
can be referenced in a cell. You can also use tuples in expressions.

●	 caption (optional)  A string displayed in the cell instead of the caption of the mem-
ber in the cube. If a tuple is used, the function returns the caption of the last member 
in the tuple.

Background  When you use CUBEMEMBER() as an argument for another cube function, 
the MDX expression instead of the displayed value is used in the argument.

Note
In the cell containing the function, the message #GETTING_DATA temporarily appears 
while the data is being queried.

Error values and messages provide information about incorrect or missing entries:

●	 If the connection name is not a valid workbook connection, the CUBEMEMBER() 
function returns the #NAME? error.

●	 If the OLAP server (or the offline cube) is not available, you get an error message. The 
content of the affected cell doesn't change.

●	 If at least one member within the tuple is invalid, the CUBEMEMBER() function 
returns the #VALUE! error.

●	 If member_expression is longer than 255 characters, the CUBEMEMBER() function 
returns the #VALUE! error.

●	 CUBEMEMBER() returns the #N/A error when:

m	 The member_expression syntax is incorrect.

m	 The member specified in the MDX query doesn’t exist in the cube.

m	 The tuple is invalid because there is no intersection for the specified values.

m	 The set contains at least one member with a different dimension from the 
other members.

●	 CUBEMEMBER() may also return the #N/A error when the connection to the data 
source is interrupted and cannot be re-established.
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Example  So that you can gain a better understanding of the use of the functions in this 
section, take a close look at the PivotTable in Figure 14-5.

Figure 14-5  The candy sales PivotTable used to demonstrate the cube functions.

The formula

=CUBEMEMBER("offLine","[Products].[Product].[All].[Cookies]")

looks for a single cell and returns the Cookies member which has the caption we looked for. 
If you use the tuple

=CUBEMEMBER("offLine", 
   "([Stores].[Store].[All].[NorthEast],[Products].[All].[Cookies], 
   [Years].[2009])")

the result is 2009 (the cookie sales in the year 2009 in the NorthEast store). If you use

=CUBEMEMBER("offLine", 
   "([Stores].[Group].[All].[North],[Stores].[Store].[All].[NorthEast]")

to find an empty intercept, you get the #N/A error. To display the word total, enter

=CUBEMEMBER("offLine","[Products].[Product].[All]","total")

You can use the cell containing the formula to create cell captions. The actual content of 
the cell is more informative if it refers to the cells with the CUBEMEMBER() entries.

See Also  All other cube functions, GETPIVOTDATA()
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CUBEMEMBERPROPERTY()
Syntax  CUBEMEMBERPROPERTY(connection,member_expression,property)

Definition  This function returns the property of a member from the cube. Use CUBEMEM-
BERPROPERTY() to validate that a member exists within the cube and to return the property 
for this member as a value.

Arguments

●	 connection (required)  A string with the name of the workbook connection to the 
cube. After you enter the first quotation mark, the existing context-sensitive data 
connections are displayed (see Figure 14-4, shown earlier).

●	 member_expression (required)  Defines the position of a member in the cube based 
on an MDX. The expression can be entered directly or can be in a cell that is refer-
enced. You can also use tuples in expressions.

●	 property (required)  The name of the property for which you want to return the 
value.

Note
For a PivotTable that retrieves data from a cube, use the PivotTable tools to find 
out whether a member has properties (see Figure 14-6).

Figure 14-6  Checking whether cube members have properties—not all members do.

Background  In the example in this section, the stores have the Group property with the 
possible values North or South (shown previously in Figure 14-5).

In the cell containing the function, the message #GETTING_DATA temporarily appears while 
the data is being queried.

Error values and messages provide information about wrong or missing entries:

●	 If the connection name is not a valid workbook connection, the 
CUBEMEMBERPROPERTY() function returns the #NAME? error.

●	 If the OLAP server (or the offline cube) is not available, you get an error message. The 
content of the affected cell doesn't change.
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●	 If the member_expression syntax is incorrect, or if the member specified by member_
expression doesn’t exist in the cube, the CUBEMEMBERPROPERTY() function returns 
the #N/A error.

●	 CUBEMEMBERPROPERTY() might return the #N/A error when the connection to the 
data source is interrupted and cannot be re-established

Example  As previously mentioned, the stores in the PivotTable have the Group properties 
North and South. The formula

=CUBEMEMBERPROPERTY("offline","[Stores].[Store].[All].[NorthEast]","group")

returns North, and the formula

=CUBEMEMBERPROPERTY("offline","[Stores].[Store].&[3]","group")

returns South. This example uses the position number of the store in the list instead of the 
store name.

See Also  All other cube functions, GETPIVOTDATA()

CUBERANKEDMEMBER()
Syntax  CUBERANKEDMEMBER(connection,set_expression,rank,caption)

Definition  This function returns the n-th member in a set.

Arguments

●	 connection (required)  A string with the name of the workbook connection to the 
cube. After you enter the first quotation mark, the existing context-sensitive data 
connections are displayed (see Figure 14-4, shown earlier).

●	 set_expression (required)  Defines the number of members in the cube based on 
an MDX. The expression can be entered directly or can be in a cell that is referenced. 
You can also use tuples in expressions.

●	 rank (required)  An integer indicating the position of a member in the set.

●	 caption (required)  A string displayed in the cell instead of the caption of the mem-
ber in the cube. If a tuple is used, the function returns the caption of the last member 
in the tuple.
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Background

Note
In the cell containing the function, the message #GETTING_DATA temporarily appears 
while the data is being queried.

Error values and messages provide information about incorrect or missing entries:

●	 If the connection name is not a valid workbook connection, the CUBERANKEDMEM-
BER() function returns the #NAME? error.

●	 If the OLAP server (or the offline cube) is not available, you get an error message. The 
content of the affected cell doesn't change.

●	 If set_expression is longer than 255 characters, the CUBERANKEDMEMBER() function 
returns the #VALUE! error.

●	 CUBERANKEDMEMBER() returns the #N/A error when:

m	 The set_expression syntax is incorrect.

m	 The set specified in the MDX query doesn’t exist in the cube.

●	 CUBERANKEDMEMBER() might return the #N/A error when the connection to the 
data source is interrupted and cannot be re-established.

Example  If you reference a cell in the formula

=CUBERANKEDMEMBER("offline",B9,1)

that returns the store set with

=CUBESET("offline","[Stores].[Store].Children", "all store  
   sales",2,"[Measures].[Sale]")

the result is NorthEast. This store has the most sales for all products and in all years. The 
nested formula

=CUBERANKEDMEMBER("offLine",CUBESET("offLine","([Stores].[Store].[All].[NorthEast],  
   [Years].Children)","all sales",2;"[Measures].[Sales]"),3)

calculates the year with the least sales for this store (position 3): 2011. 

See Also  All other cube functions, GETPIVOTDATA()
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CUBESET()
Syntax  CUBESET(connection,set_expression,caption,sort_order,sort_by) 

Definition  This function returns a calculated set of members by sending a set expression 
to the cube on the server, which creates the set and then returns that set to Excel. The con-
tent of the cell and the actual value of the cell are different.

Arguments

●	 connection (required)  A string with the name of the workbook connection to the 
cube. After you enter the first quotation mark, the existing context-sensitive data 
connections are displayed (see Figure 14-4, shown earlier).

●	 set_expression (required)  Defines the number of elements in the cube based on 
an MDX. The expression can be entered directly or can be in a cell that is referenced. 
You can also use tuples in expressions.

●	 caption (optional)  A string displayed in the cell instead of the caption of the mem-
ber in the cube. If a tuple is used, the function returns the caption of the last member 
in the tuple.

●	 sort_order (optional)  The type of sorting; the values are integers that affect the 
treatment of the fifth argument, sort_by (see Table 14-3). The formulas are context-
sensitive (see Figure 14-7).

Figure 14-7  Tooltips show the choices for the CUBESET() function.

Table 14-3  Integers for the Fourth Argument of the CUBESET() Function

Integer Description Impact on the 	
Fifth Argument

0 Leaves the set in the existing order in the cube Ignored
1 Sorts the set in ascending order by sort_by Required
2 Sorts the set in descending order by sort_by Required
3 Sorts the set in ascending alphabetical order Ignored
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Integer Description Impact on the 	
Fifth Argument

4 Sorts the set in descending alphabetical order Ignored
5 Sorts the set in natural ascending order Ignored
6 Sorts the set in natural descending order Ignored

The default value of the fourth argument is 0. An alphabetical sorting for a set of 
tuples is based on the last element in the tuple. You will find more information about 
the different sort orders in the SQL Analysis Services Help.

●	 sort_by (optional)  The sort_by argument depends on the fourth argument and 
defines the values in the set that is sorted. If sort_by is not provided but sort_order 
requires sort_by, the function returns the #VALUE! error.

Background  When you use CUBESET() as an argument for another cube function, the set 
instead of the displayed value is used in the argument.

Note 
In the cell containing the function, the message #GETTING_DATA temporarily appears 
while the data is being queried.

Error values and messages provide information about incorrect or missing entries:

●	 If the connection name is not a valid workbook connection, the CUBESET() function 
returns the #NAME? error.

●	 If the OLAP server (or the offline cube) is not available, you get an error message. The 
content of the affected cell doesn't change.

●	 If set_expression is longer than 255 characters, the CUBESET() function returns the 
#VALUE! error.

●	 CUBESET() returns the #N/A error when:

m	 The set_expression syntax is incorrect.

m	 The set specified in the MDX query doesn’t exist in the cube.

m	 The set contains at least one member with a different dimension from the 
other members.

●	 CUBESET() might return the #N/A error when the connection to the data source is 
interrupted and cannot be re-established.
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Example  The formula

=CUBESET("offline","[Stores].[Store].Children",  
   "all store sales",2,"[Measures].[Sale]")

returns the sorted set of all stores based on the sales (all products and years). The store with 
the largest sale is listed first.

You can use the cell containing the formula to create cell labels. The actual content of the 
cell is more informative if it refers to the cells with the CUBESET() entries.

See Also  All other cube functions, GETPIVOTDATA()

CUBESETCOUNT()
Syntax  CUBESETCOUNT(set)

Definition  This function returns the number of members in a set.

Argument

●	 set (required)  A set defined with the CUBESET() function or a reference to the cell 
containing members of the cube

Background  The result of this function is an integer. If the argument causes an error, this 
error is also returned as the result.

Note
In the cell containing the function, the message #GETTING_DATA temporarily appears 
while the data is being queried.

Example  In the CUBESETCOUNT() function, if you reference a cell that returns the sorted 
set of the stores like

=CUBESET("offline","[Stores].[Store].Children", "all store sales",2,"[Measures].
[Sale]")

the result will be 4. You get the same result if you pass this formula as an argument. The 
keyword Children is not context sensitive.

See Also  All other cube functions, GETPIVOTDATA()
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CUBEVALUE()
Syntax  CUBEVALUE(connection,member_expression1,member_expression2,...)

Definition  This function returns the value of a member (cell) from a cube.

Arguments

●	 connection (required)  A string with the name of the workbook connection to the 
cube. After you enter the first quotation mark, the existing context-sensitive data 
connections are displayed (see Figure 14-4, shown earlier).

●	 member_expression1 (required) and member_expression2 (optional)  At least 
one and up through 255 expressions that define the position of a member in the 
cube based on an MDX. The expression can be entered directly or can be in a cell 
that is referenced. You can also use tuples in expressions. Alternatively, member_
expression can be a set defined with the CUBESET() function. If no measure is speci-
fied in member_expression, the default measure for that cube is used.

Because the argument can be repeated, you can define intersections. You can also 
use tuples.

Background  When you use CUBEVALUE() as an argument for another cube function, the 
MDX expression instead of the displayed value is used in the argument.

Note
In the cell containing the function, the message #GETTING_DATA temporarily appears 
while the data is being queried.

Error values and messages provide information about wrong or missing entries:

●	 If the connection name is not a valid workbook connection, the CUBEVALUE() func-
tion returns the #NAME? error.

●	 If the OLAP server (or the offline cube) is not available, you get an error message. The 
content of the affected cell doesn't change.

●	 If at least one member within the arguments or the tuple is invalid, the CUBEVALUE() 
function returns the #VALUE! error.

●	 If member_expression is longer than 255 characters, the CUBEVALUE() function 
returns the #VALUE! error.
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●	 CUBEVALUE() returns the #N/A error when:

m	 The member_expression syntax is incorrect.

m	 The member specified in the MDX query doesn’t exist in the cube.

m	 The tuple is invalid because there is no intersection for the specified values.

m	 The set contains at least one member with a different dimension from the 
other members.

●	 CUBEVALUE() might return the #N/A error when the connection to the data source is 
interrupted and cannot be re-established

The formula

=CUBEVALUE("offLine","[Measures].[GrossSales]","[Stores].[Store].[All]. 
   [NorthEast]"," [Years].[Year].[All].[2009]","[Products].[Product]. 
   [All].[Cookies]")

calculates the gross sales for cookies in the store NorthEast in the year 2009: $1,856.40. You 
get the same result if you use a tuple (the arguments of the previous formula are enclosed 
in parentheses):

=CUBEVALUE("offline","([Measures].[GrossSales],[Stores].[Store].[All].[NorthEast],  
   [Years].[Year].[All].[2009],[Products].[Product].[All].[Cookies])")

If you enter the formula

=CUBEMEMBER("offLine","[Products].[Product].[All].[Cookies]")

in cell B3, the formula

=CUBEVALUE("offline",B3)

returns the total sales for cookies: $21,796. 

You can also use the examples for the CUBEKPIMEMBER() function. The formula

=CUBEVALUE("offline",CUBERANKEDMEMBER("offline",CUBESET("offline","[Stores] 
   .[Store].Children","all store sales",2;"[Measures].[sale]"),1))

returns $10,814 for the total sales of the best store (NorthEast).

See Also  All other cube functions, GETPIVOTDATA()

Sample Files
Use the offline cubeTest.xlsx sample file. This sample file and the additional files are 
found in the Chapter14 folder. For more information about the sample files, see the 
section titled “Using the Sample Files” on page xxiii.
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= (equal sign)

assigning results to custom functions,  195

equal to operator,  107, 296, 639

preceding formulas,  103

in search criteria,  639

=? wildcard,  639

=* wildcard,  639

/ (forward slash)

in date values,  41

division operator,  104, 106

- (minus sign)

correcting position of,  55

in date values,  41

negative value operator,  55, 106

subtraction operator,  104, 106

() (parentheses)

cells formatted with, determining,  349

enclosing function arguments,  143

grouping expressions in formulas,  105–106

highlighting of,  106

% (percent operator),  104, 106

+ (plus sign)

addition operator,  104, 106

in keyboard shortucuts,  xxii

? (question mark), wildcard,  637, 639

‘ (single quote), indicating left-aligned text,  349

“ “ (space)

in database record,  638

in functions, avoiding,  144

highlighting cells containing,  179

including in cells,  108

intersection operator,  108, 110–111

removing from text,  54–55

in search criteria,  638

Symbols
64-bit version, Excel 2010,  1013

1900 date system, for Windows,  42

1904 date system, for Mac,  42, 46

& (ampersand), text operator,  107–108

<> (angle brackets)

> greater than operator,  107, 296, 639

>= greater than or equal to operator,  107, 296, 639

< less than operator,  107, 296, 639

<= less than or equal to operator,  107, 296, 639

<> not equal to operator,  107, 296, 639

<> in search criteria,  638

‘ (apostrophe), preceding comments in custom 
functions,  201

* (asterisk)

multiplication operator,  104, 106

wildcard,  637, 639

@ (at sign), in cell references in tables,  117

\ (backslash), indicating fill-aligned text,  349

{} (braces), enclosing array formulas,  119, 120

^ (caret)

exponentiation operator,  104, 106

indicating centered text,  349

: (colon), range operator,  108–110

, (comma)

connection operator,  108, 110

separating function arguments,  143, 144

$ (dollar sign), preceding cell references,  114, 116

“ (double quote), indicating right-aligned text,  349

“” (double quotes)

enclosing text or spaces in cells,  107, 108

enclosing text with wildcards,  639
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_ (underscore), continuing lines in custom functions,  205

A
ABS() function,  813–814

absolute references,  113–115. See also mixed references

absolute value,  813–814, 935–937

ACCRINT() function,  695–697

ACCRINTM() function,  697–699

accrued interest,  695–697, 697–699, 713–714

ACOS() function,  814–816

ACOSH() function,  816–817

add-ins

PowerPivot add-in,  1015

saving custom functions in,  218

Solver add-in,  1015

Add-Ins dialog box,  44

addition operator (+),  104, 106

Add Procedure dialog box,  198–199

ADDRESS() function,  308–311

address (of a cell). See cell references

address (postal address), separating parts of,  50–51

AGGREGATE() function,  818–821, 1014

algebraic form of complex number,  942–944

AM designation, for times,  43

AMORDEGRC() function,  699–701

AMORLINC() function,  702–703

amortization calculations,  90, 691

ampersand (&), text operator,  107–108

analytical statistics,  67

Analyze tab, Data group, Refresh button,  38

AND() function,  60, 291–292

angle brackets (<>)

> greater than operator,  107, 296, 639

>= greater than or equal to operator,  107, 296, 639

< less than operator,  107, 296, 639

<= less than or equal to operator,  107, 296, 639

<> not equal to operator,  107, 296, 639

<> in search criteria,  638

annuities,  85–89, 690

amount of,  762–764

duration of annuity calculation,  747–750

interest part of,  736–738

interest rate for,  779–783

loans repaid as annuity loans,  713–714

repayment part of,  765–766

anticipative interest rate,  720–722

anticipative interest yield,  690

apostrophe (‘), preceding comments in custom 
functions,  201

Arabic numbers, converting to Roman numerals,  867–869

arccosine,  814–816

arctangent,  824–825, 825–826

AreaCircle1() custom function,  214–216

AreaCircle() custom function,  196–203

AreaQuad() custom function,  203–210

AreaSect() custom function,  210–211

AREAS() function,  311–312

arguments

of built-in functions,  143, 144–146, 152, 156

of custom functions,  200, 203–205

arithmetic-degressive (digital) method of 
depreciation,  786–787

arithmetic functions. See mathematical functions

arithmetic operators,  104–106

array formulas,  119–120

arrays,  810. See cell ranges

determinant of,  850–851

inverse of,  851–854

multiplication of,  854–855

ASC() function,  256–257

ASIN() function,  821–822

ASINH() function,  822–823

asset depreciation

with arithmetic-degressive (digital) method,  786–787

based on French accounting system,  699–701

with geometric-degressive method,  717–718, 792–793

with linear depreciation method,  702–703, 785–786

with multiple-rate method,  719–720

asterisk (*)

multiplication operator,  104, 106

wildcard,  637, 639

ATAN2() function,  825–826

ATAN() function,  824–825

ATANH() function,  827–828
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at sign (@), in cell references in tables,  117

auditing formulas,  134–138

AutoCorrect, saving formulas with,  156–157

AutoFill series,  4–7

AutoFilter

for formatting,  178

limits for,  1012

list control used by,  640

automatic calculation of formulas,  134

AVEDEV() function,  388–389

average absolute deviation,  388–389

AVERAGEA() function,  392–394

AVERAGE() function,  71, 390–392, 818

AVERAGEIF() function,  72, 395–398, 1011

AVERAGEIFS() function,  72, 398–401, 1011

averages. See mean values

B
backslash (\), indicating fill-aligned text,  349

BAHTTEXT() function,  257–258

Bessel functions,  955

of first kind,  957–959

of first kind, modified,  955–957

of second kind,  961–963

of second kind, modified,  959–961

BESSELI() function,  955–957

BESSELJ() function,  957–959

BESSELK() function,  959–961

BESSELY() function,  961–963

BETADIST() and BETA.DIST() functions,  401–403

beta distribution,  401–403, 403–407

BETAINV() and BETA.INV() functions,  403–407

BIN2DEC() function,  910–911

BIN2HEX() function,  911–912

BIN2OCT() function,  912–913

binary system,  907, 908–909

converting decimal to,  914–915

converting hexadecimal to,  918–920

converting octal to,  922–924

converting to decimal,  910–911

converting to hexadecimal,  911–912

converting to octal,  912–913

BINOMDIST() and BINOM.DIST() functions,  407–411

binomial distribution,  407–411, 411–413, 531–532

BINOM.INV() function,  411–413

blank cells. See empty cells

blank, determining whether cell is,  65

Boolean comparison operators. See comparison operators

boolean data type. See logical data type

braces ({}), enclosing array formulas,  119, 120

branching, VBA,  206–210

built-in functions. See functions

buttons. See controls

C
calculated search criteria,  639

calculation clusters,  1014, 1015

calculations. See formulas; functions

caret (̂ )

exponentiation operator,  104, 106

indicating centered text,  349

case-sensitivity

of formulas,  112

of functions,  147

CEILING() function,  828–829

CEILING.PRECISE() function,  829–830, 1014

CELL() function,  55, 160, 162, 348–352

cell ranges

as function arguments,  145–146, 152

largest values in,  503–505

number of columns in,  315–316

number of contiguous ranges in a reference,  311–312

number of empty cells in,  352–353

number of rows in,  338–339

references to,  108, 109–110

transposing,  341–343

cell reference data type,  144

cell references,  111–119

absolute references,  113–115

to cell ranges,  108, 109–110

changing type of, F4 key for,  117

circular references,  117–119

column number of,  314–315

converting row and column numbers to,  308–311
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converting text string to,  326–327

determining, for a cell,  348

determining whether value is,  369–371

to entire columns or rows,  109–110

to entire worksheet,  110

as function arguments,  145, 152

to intersection of cells,  108, 110–111

mixed references,  115–117

to nonadjacent cells,  108, 110

number of contiguous ranges in a reference,  311–312

number of rows in,  338–339

relative references,  113

return reference that is offset from starting 
reference,  333–337

row number of,  337–338

of upper-left cell, determining,  357

cells

color of,  349

column number of,  349

contents of,  349

data type of,  349

empty

database search criteria for,  639

determining if cell is,  359–360, 435

formatting. See formatting

formatting of, determining,  349

information about,  348–352

justification of,  349

limits for,  1012

row number of,  349

validating. See validation

width of,  348

CHAR() function,  57, 179, 258–259

charts

column charts,  21–23

formatting,  25–28

miniature, in a cell. See sparklines

pie charts,  24–25

from PivotTable data. See PivotCharts

check boxes. See controls

CHIDIST() function,  414–416

CHISQ.DIST() function,  413–414

CHISQ.DIST.RT() function,  414–416

CHISQ.INV() function,  416–417

CHISQ.INV.RT() function,  418–419

CHISQ.TEST() function,  420–422

chi-squared distribution,  413–414, 414–416, 416–417, 
418–419, 420–422

CHITEST() function,  420–422

CHOOSE() function,  312–314

circular references,  117–119

CLEAN() function,  259–260

CODE() function,  260–261

colon (:), range operator,  108–110

color

limits for,  1012

of a cell,  349

column charts,  21–23

COLUMN() function,  314–315

column number, determining for a cell,  349

COLUMNS() function,  315–316

columns, in database,  635. See also database; database 
functions

columns, in worksheet

limits for,  1012

references to entire columns,  109–110

COM automation, retrieving real-time data from,  339–341

combinations, number of,  830–831

COMBIN() function,  830–831

comma (,)

connection operator,  108, 110

separating function arguments,  143, 144

comments, VBA,  201

comparison operators,  106–107, 296

COMPLEX() function,  934–935

complex number functions,  905, 931–932

absolute value of complex number,  935–937

algebraic form of complex number,  942–944

argument Φ for,  939

complex conjugate of complex number,  940

cosine of complex number,  940–941

division of complex numbers,  941–942

exponentiation of complex number,  946–948
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imaginary part of complex number,  938

linking real numbers to create a complex 
number,  934–935

list of,  905–906

logarithm of complex number,  945, 946

multiplication of complex numbers,  948–949

natural logarithm of complex number,  944–945

real part of complex number,  949

sine of complex number,  950

square root of complex number,  950–951

subtraction of complex numbers,  952

sum of complex numbers,  953

compound interest,  690

CONCATENATE() function,  57, 261–262

concatenating text,  56–57

conditional calculations. See also logical functions

AVERAGEIF() function,  395–398, 1011

AVERAGEIFS() function,  398–401, 1011

COUNTIF() function,  172–174, 191, 435–438

COUNTIFS() function,  438–440, 1011

SUMIF() function,  886–888

SUMIFS() function,  888–889, 1011, 1012

conditional formatting

for alternate rows in a list,  176–177

changing,  185

comparing table content,  174–176

finding cells containing,  185–186

formulas for,  166–187

for grouping data,  182–183

for holiday dates,  169–172

for identical values,  172–174

KPIs in,  21

for largest values,  505

limits for,  1012

for range of values,  18–21

for reference lines in tables,  179–182

for spaces in cells,  179

for subtotals,  183–185

toolbar icon for,  186–187

for top three values,  177–178

troubleshooting,  187

for weekend dates,  167–170

Conditional Formatting dialog box,  166, 178, 180, 181, 
183, 185

conditions, VBA,  206–210

CONFIDENCE() function,  423–426

confidence interval,  423–426, 427

CONFIDENCE.T() function,  427

connection operator (,),  108, 110

constants

in formulas,  105, 111

as function arguments,  145

contact information for this book,  xxxvi

controls,  640

conventions used in this book,  xxii–xxiii

conversion functions

Arabic numbers to Roman numerals,  867–869

between measurement systems,  926–931

binary number to decimal number,  910–911

binary number to hexadecimal number,  911–912

binary number to octal number,  912–913

decimal number to binary number,  914–915

decimal number to hexadecimal number,  915–917

decimal number to octal number,  917–918

degrees to radians,  863–865

for engineering,  904, 907–909

hexadecimal number to binary number,  918–920

hexadecimal number to decimal number,  920–921

hexadecimal number to octal number,  921–922

octal number to binary number,  922–924

octal number to decimal number,  924

octal number to hexadecimal number,  925–926

radians to degrees,  835–837

CONVERT() function,  926–931

correlation,  68, 428–431

CORREL() function,  428–431

COS() function,  832–834

COSH() function,  834–835

cosine,  832–834, 940–941

COUNTA() function,  71, 434, 818

COUNTBLANK() function,  352–353, 435

COUNT() function,  431–433, 818

COUNTIF() function,  172–174, 191, 435–438

COUNTIFS() function,  438–440, 1011
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counting

all numbers in argument list,  431–433, 818

all numbers in database matching search 
criteria,  643–645

all values in argument list,  434, 818

all values in database matching search criteria,  645–647

all values matching search criteria,  435–438, 438–440

cells,  71

cells that are not empty,  79

empty cells,  435

list of functions for,  69–70

COUPDAYBS() function,  704–705

COUPDAYS() function,  705–706

COUPDAYSNC() function,  707–708

COUPNCD() function,  708–709

COUPNUM() function,  710–711

COUPPCD() function,  711–712

COVAR() function,  441–444

covariance,  441–444, 444–445, 445–446

COVARIANCE.P() function,  444–445

COVARIANCE.S() function,  445–446

Create Names dialog box,  178

Create Table dialog box,  12

CRITBINOM() function,  411–413

cube functions,  80–84, 673–676, 1011–1012

count of members in set,  686

KPI (Key Performance Indicator),  676–678

list of,  675–676, 1003

offline cube as data source,  673–674

retrieving cube members,  678–680

retrieving member properties,  681–682

retrieving members of specified rank,  682–683

retrieving member values,  687–688

retrieving set of cube members,  684–686

SQL Server Analysis Services as data source,  673

CUBEKPIMEMBER() function,  676–678

CUBEMEMBER() function,  678–680

CUBEMEMBERPROPERTY() function,  681–682

CUBERANKEDMEMBER() function,  84, 682–683

CUBESETCOUNT() function,  686

CUBESET() function,  684–686

CUBEVALUE() function,  84, 687–688

CUMIPMT() function,  713–714

CUMPRINC() function,  715–717

currency

decimal places as numerator of fraction, converting,  723–
724, 724–725

formatting numeric values as,  10, 262–263

current directory, path of,  357

custom functions

arguments for

declaring,  200

multiple arguments,  203–205

optional arguments,  204–205, 210–211

branching with logical conditions,  206–210

categories for,  1012

comments in,  201

creating,  194–203

Excel built-in functions in,  215–216

list of, displaying,  203

loops in,  212–214

naming,  199

public,  200

return value, data type for,  200

saving in add-ins,  218

splitting statements across multiple lines,  205

testing,  202

using,  217

variables in,  213–214

Customize dialog box,  187

D
D1–D9, indicating date and time formats,  350

data. See dates and times; logical values; numeric values; 
text

database,  635–636

controls in,  640

search criteria for,  636–639

spaces in,  638

database functions,  73–80

arguments in,  636–638

counting,  79

counting records,  643–645, 645–647

dynamic names used in,  73–78

list of,  640–641, 1002–1003
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maximum value of column,  649–650

mean values,  80, 641–643

minimum value of column,  650–651

multiplication of column values,  652–654

PivotTable reports, retrieving data from,  664–672

requirements for,  73

retrieving records,  647–648

search criteria for,  636–639

standard deviation,  654–655, 656–657

subtotal,  883–885

sum of column values,  657–660

variance,  661–662, 662–663

data cubes, functions for. See cube functions

data functions. See numeric values, functions for

data series

individual,  4–7

month,  2–4

data tables. See tables (formerly called lists)

data types

determining, for a value or cell,  349, 375–378

list of,  144

data validation. See validation

Data Validation dialog box,  188, 189, 190, 191

DATEDIF() function,  222–223

DATE() function,  220–222

dates and times,  41–50

conditional formatting based on

for holidays,  169–172

for weekends,  167–170

conversions of

between measurement units,  927

from text to Excel time,  241

from separate parts to Excel date,  220–222

from separate parts to Excel time,  239–240

from text to Excel date,  224–225

current date, determining,  237–238, 242

current time

determining,  237–238

entering,  45

data series containing,  2–4

date calculations

Daylight Saving Time,  45

day of the year,  45

leap years,  44

months added or subtracted from start date,  228–229, 
230–231

quarters of the year,  49

using in names,  163

work days added or subtracted from start date,  247–
249, 249–251

Excel date system for,  42–43

extracting parts of

day number,  225–226

hour,  231–232

minute,  232–233

month number,  233–234

second,  238–239

weekday number,  243–245

week number,  246–247

year,  251–252

formatting,  43

functions for

enabling,  44

list of,  219–220, 993–994

interval (difference) calculations

fraction of a year between two dates,  252–254

number of days between dates,  226–228

number of work days between dates,  234–235, 
236–237

number of years, months, or days between dates,  222–
223

time calculations

adding times,  48

decimal (industrial) hours, converting to,  49–50

including other types of values,  48

rounding times,  49

subtracting times,  46–48

values for, entering,  41, 45

date/time data type,  144

DATEVALUE() function,  224–225

DAVERAGE() function,  80, 641–643

DAY() function,  225–226

Daylight Saving Time, calculating,  45

DAYS360() function,  85, 226–228

DB() function,  717–718
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DCOUNTA() function,  79, 645–647

DCOUNT() function,  643–645

DDB() function,  719–720

DEC2BIN() function,  914–915

DEC2HEX() function,  915–917

DEC2OCT() function,  917–918

decimal (industrial) hours,  49–50

decimal system,  907

converting binary to,  910–911

converting hexadecimal to,  920–921

converting octal to,  924

converting to binary,  914–915

converting to hexadecimal,  915–917

converting to octal,  917–918

degrees

converting radians to,  835–837

converting to radians,  863–865

DEGREES() function,  835–837

DELTA() function,  967–969

depreciation of assets. See asset depreciation

descriptive statistics,  67

Design tab (PowerPivot),  97, 98

determinant of an array,  850–851

Developer tab, Visual Basic button,  196

deviations

average absolute,  388–389

squared, sum of,  446–448

standard deviation. See standard deviation

DEVSQ() function,  446–448

DGET() function,  647–648

digital (arithmetic-degressive) method of 
depreciation,  786–787

DigitSum() custom function,  211–214

Dirac delta function,  967

DISC() function,  720–722

distributions

beta distribution,  401–403, 403–407

binomial distribution,  407–411, 411–413

chi-squared distribution,  413–414, 414–416, 416–417, 
418–419, 420–422

F-distribution,  452–453, 453–455, 456, 457–459

frequency distribution,  472–476

gamma distribution,  476–480, 481–482

hypergeometric distribution,  494–497

lognormal distribution,  515–518, 518–519

negative binomial distribution,  531–532

normal distribution,  533–536, 537–539, 539–541, 
542–544

Poisson distribution,  558–560

skewness of,  575–578

standardized normal distribution,  583–585

t-distribution,  599, 600, 601–602, 603, 604–606

Weibull distribution,  629–632

#DIV/0! error,  66, 354

division,  863

of complex numbers,  941–942

remainder of,  855–857

division operator (/),  104, 106

DMAX() function,  649–650

DMIN() function,  650–651

DOLLARDE() function,  723–724

DOLLARFR() function,  724–725

DOLLAR() function,  262–263

dollar sign ($), preceding cell references,  114, 116

double factorial,  840–841

double quote (“), indicating right-aligned text,  349

double quotes (“”)

enclosing text or spaces in cells,  107, 108

enclosing text with wildcards,  639

Do Until loops, VBA,  212

Do While loops, VBA,  212

DPRODUCT() function,  652–654

DSTDEV() function,  654–655

DSTDEVP() function,  656–657

DSUM() function,  80, 657–660

DURATION() function,  725–727

DVAR() function,  661–662

DVARP() function,  662–663

dynamic name, for database,  73–78

dynamic range names,  163–165

E
E2, indicating scientific format,  350

eBook edition of this book,  xxiii
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EDATE() function,  228–229

Edit Relationship dialog box,  98

EFFECT() function,  727–729

Else keyword, VBA,  206

empty cells

database search criteria for,  639

determining if cell is,  435

empty, determining whether cell is,  65

End Function statement, VBA,  195

energy measurements, conversions between,  928

engineering functions,  903–906

complex number functions,  905, 931–932

absolute value of complex number,  935–937

algebraic form of complex number,  942–944

argument Φ for,  939

complex conjugate of complex number,  940

cosine of complex number,  940–941

division of complex numbers,  941–942

exponentiation of complex number,  946–948

imaginary part of complex number,  938

linking real numbers to create a complex num-
ber,  934–935

logarithm of complex number,  945, 946

multiplication of complex numbers,  948–949

natural logarithm of complex number,  944–945

real part of complex number,  949

sine of complex number,  950

square root of complex number,  950–951

subtraction of complex numbers,  952

sum of complex numbers,  953

conversion functions,  904, 907–909

between measurement systems,  926–931

binary number to hexadecimal number,  911–912

binary number to octal number,  912–913

decimal number to binary number,  914–915

decimal number to hexadecimal number,  915–917

decimal number to octal number,  917–918

hexadecimal number to binary number,  918–920

hexadecimal number to decimal number,  920–921

hexadecimal number to octal number,  921–922

octal number to binary number,  922–924

octal number to decimal number,  924

octal number to hexadecimal number,  925–926

higher mathematics functions,  906

Bessel function of first kind,  957–959

Bessel function of second kind,  961–963

complement to Gauss error function,  966–967

modified Bessel function of first kind,  955–957

modified Bessel function of second kind,  959–961

probability integrals,  963–966

list of,  904–906, 1008–1009

saltus functions,  906, 967–970

EOMONTH() function,  230–231

equal sign (=)

assigning results to custom functions,  195

equal to operator,  107, 296, 639

preceding formulas,  103

in search criteria,  639

=? wildcard,  639

=* wildcard,  639

ERFC() function,  966–967

ERFC.PRECISE() function,  966–967, 1014

ERF() function,  963–966

ERF.PRECISE() function,  963–966, 1014

errata information for this book,  xxxvi

error integrals,  955, 963–966, 966–967

errors

checking for,  300–301

determining if value is,  361–362

determining whether cell contains,  65–66

determining whether value is,  360–361

#DIV/0! error,  66

list of,  300

#N/A error. See #N/A error

#NAME? error,  217

type of, determining,  354–356

ERROR.TYPE() function,  354–356

EVEN() function,  837–838

even number, determining whether cell is,  65

EXACT() function,  264–265

example files for this book,  xxiii–xxxv

Excel

memory usage of, determining,  357

version of, determining,  357
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circular references, error for,  117

conditional formatting,  166–167, 168–169, 185–187

copying and pasting formulas,  131

copying formulas with Fill function,  129

custom functions, list of,  203

defining names,  160–161

EDATE() function, as add-in,  228

engineering functions, enabling,  903

EOMONTH() function, as add-in,  230

Excel options,  6

extending selections,  124

financial functions, enabling,  691

formula auditing,  135, 137

formula calculation types,  133

formulas in data validation,  190

function ScreenTips, displaying,  147

ISEVEN() function, as add-in,  362

ISODD() function, as add-in,  368

limits in, list of,  1012

mathematical and trigonometry functions, enabling,  811

moving cells,  125

nesting limits for functions,  142, 143

Pivot functions,  30

protecting formulas,  132

Visual Basic Editor,  196

Excel 2003 (differences from Excel 2010)

1904 date system, enabling,  46

analysis functions, enabling,  44

cell formatting,  42, 48

column limits,  73

lists, assigning dynamic names using,  77

row limits,  73

Excel 2007,  1011–1013

AVERAGEIF() function,  395–398, 1011

AVERAGEIFS() function,  398–401, 1011

converting files for earlier Excel versions,  xxiv

COUNTIFS() function,  438–440, 1011

cube functions,  1011–1012

custom functions, sharing,  218

Excel options,  6

file formats,  1013

IFERROR() function,  1011, 1012

limits in, list of,  1012

statistical functions added in,  385, 398, 438

SUMIFS() function,  888–889, 1011, 1012

Excel 2010,  1013–1016

64-bit version,  1013

AGGREGATE() function,  818–821, 1014

calculation clusters,  1014, 1015

CEILING.PRECISE() function,  829–830, 1014

converting files for earlier Excel versions,  xxiv

ERFC.PRECISE() function,  966–967, 1014

ERF.PRECISE() function,  963–966, 1014

file formats,  1013

FLOOR.PRECISE() function,  842–843, 1014

limits in, list of,  1012

NETWORKDAYS.INTL() function,  1014

PowerPivot,  1015

Solver add-in,  1015

statistical functions

compatibility category of,  385

new and changed, list of,  386–387

WORKDAY.INTL() function,  1014

Excel 2010 (new and changed features in)

PowerPivot for Excel 2010 add-in,  93–102

statistical functions,  70

Excel Cluster Connector,  1015

Excel Options dialog box,  5

exchange rates. See investments

EXP() function,  838–839

EXPON.DIST() function,  448–451

EXPONDIST() function,  448–451

exponential curve for regression analyses,  511–515

exponential distributed random variable, probability 
of,  448–451

exponential trend,  487–491

exponentiation,  838–839, 860–861, 946–948

exponentiation operator (̂ ),  104, 106

expressions, as function arguments,  145, 146

F
F0 or F2, indicating number formats,  350

F4 key, changing reference types,  117
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FACTDOUBLE() function,  840–841

FACT() function,  839–840

factorial,  839–840, 840–841

FALSE() function,  293–295

FDIST() and F.DIST.RT()  functions,  453–455

F.DIST() function,  452–453

F-distribution

left quantile,  452–453, 456

right quantile,  453–455, 457–459

fields, in database,  635, 636. See also database; database 
functions

file extensions,  218, 1013

.xlam file extension,  1013

.xlsb file extension,  1013

.xlsm file extension,  218, 1013

.xlsx file extension,  218, 1013

.xltm file extension,  1013

.xltx file extension,  1013

file name of workbook, determining,  55, 161, 349

File tab, Options button,  196

filtering tabular data. See PivotTables

financial functions,  84–90, 690–695

amortization calculations,  691

annuities,  690

amount of annuity,  762–764

duration of annuity calculation,  747–750

interest part of,  736–738

interest rate for,  779–783

loans repaid as annuity loans,  713–714

repayment part of,  765–766

asset depreciation

with arithmetic-degressive (digital) method,  786–787

based on French accounting system,  699–701

with geometric-degressive method,  717–718, 792–793

with linear depreciation method,  702–703, 785–786

with multiple-rate method,  719–720

capital value for series of surpluses,  796–798

cash value of regular payment flow,  776–779

final value

for regular payment flow,  729–732

for variable periods,  732–734

fixed-interest securities

accrued interest of,  695–697, 697–699

annual yield of,  806–808

date of first interest payment,  708–709

date of last interest payment,  711–712

days in interest period,  705–706

days since last interest payment,  704–705

days to next coupon date,  707–708

Macauley Duration for,  725–727

modified duration for,  742–743

number of interest payments,  710–711

price of,  752–755, 757–759, 767–771

yield of,  755–757, 759–761, 799–803

interest,  85–89, 148–150

accrued interest,  695–697, 697–699, 713–714

annual interest rate in arrears,  788–789

anticipative interest rate,  720–722

anticipative interest yield,  690

compound interest,  690

duration of compound interest rate, annuity, or repay-
ment,  747–750

effective annual interest rate,  727–729

interest payment for annuity,  736–738

interest rate for compound interest and annui-
ties,  779–783

interest rate for marked down securities,  734–736

interest yield in arrears,  690

internal interest rate,  794–796

internal interest rate of dynamic investment,  738–740

nominal interest rate,  746

period interest rate, calculated from annual,  741–742

simple interest,  690

investments,  89–90, 691

internal interest rate of dynamic investment,  738–740

internal yield of investment,  744–745

list of,  692–695, 1003–1005

loan repayments,  690

accrued interest between two points,  713–714

net cash value of future period surpluses,  750–752

repayment portion between two points,  715–717

price,  691. See also securities

repayment amount of a deposit,  783–785
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securities. See also fixed-interest securities

annual yield for marked down security,  803–806

anticipative interest rate,  720–722

decimal places as numerator of fraction, convert-
ing,  723–724, 724–725

disbursement amount of simply discounted secu-
rity,  771–774

interest rate for marked down securities,  734–736

price of discounted securities as percent,  789–790

price of security with simple interest yield in ar-
rears,  774–776

yield of discounted security,  790–791

FIND() and FINDB() functions,  51, 52, 55, 160–161, 161, 
179, 266–267

Find And Replace dialog box,  179

FINV() and F.INV.RT() functions,  457–459

F.INV() function,  456

FISHER() function,  462–466

FISHERINV() function,  467

Fisher transformation,  462–466, 467

FIXED() function,  268–269

FLOOR() function,  841–842

FLOOR.PRECISE() function,  842–843, 1014

fonts used in this book,  xxii

force measurements, conversions between,  928

FORECAST() function,  468–471

forecasts. See probability

Format Cells dialog box,  19, 48

Format dialog box,  167

formatting

charts,  25–28

conditional. See conditional formatting

dates,  43

determining, for a cell,  349

limits for,  1012

numeric values

as currency,  10, 262–263

as percentage,  17

table formats,  12–13

formulas

array formulas,  119–120

auditing,  134–138

calculation options for,  133–134

case-sensitivity of,  112

cell references in. See cell references

combining results from multiple formulas,  107–108

for conditional formatting,  166–187

constants in,  105, 111

converting to fixed values,  131–132

copying,  123–125, 126–130

absolute references in,  113–115

mixed references in,  115–116

relative references in,  113

editing,  155

entering,  103–104, 112–113

in multiple cells,  122

in multiple worksheets,  122

hiding,  133

highlighting cells referenced by,  123

limits for,  1012

moving,  125–126

in names,  159–165

operators in. See operators

partial calculations in, analyzing,  158

protecting from being changed,  132–133

results of, converting to fixed values,  8–10

saving to repeat in other workbooks,  156–157

selecting cells containing,  122–123

tracing,  136–137

troubleshooting,  138–140

for validation,  187–192

viewing formulas in cells,  121

viewing results in cell,  104

Formulas tab

Add Function (fx) button,  203

Defined Names group, Define Names button,  63, 74, 76, 
160–161

Insert Function button,  148

For Next loops, VBA,  212–214

forward slash (/)

in date values,  41

division operator,  104, 106
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French accounting system

depreciation of assets,  699–701

linear depreciation of assets,  702–703

frequency distribution,  472–476

FREQUENCY() function,  472–476

FTEST() and F.TEST() functions,  460–462

f-test, statistics from,  460–462

Function Arguments dialog box,  150

Function Assistant,  148

help from,  152–153

required and optional arguments in,  144

searching for functions,  151

functions. See also specific functions

arguments for,  143, 144–146, 152, 156, 1012

case sensitivity of,  147

for conditional formatting,  166–187

cube functions,  80–84, 673–676, 1003. See also cube 
functions

custom functions

arguments for,  200, 203–205

branching with logical conditions,  206–210

comments in,  201

creating,  194–203

Excel built-in functions in,  215–216

list of, displaying,  203

loops in,  212–214

naming,  199

optional arguments for,  204–205, 210–211

public,  200

return value, data type for,  200

saving in add-ins,  218

splitting statements across multiple lines,  205

testing,  202

using,  217

variables in,  213–214

database functions,  73–80, 640–641, 1002–1003. See 
also database functions

date and time functions,  41–50, 219–220, 993–994

editing,  155, 156

engineering functions,  903–906, 1008–1009. See 
also engineering functions

entering,  146–150

financial functions,  84–90, 690–695, 1003–1005. See 
also financial functions

help for,  152–153

information functions,  64–66, 347–348, 997. See 
also information functions

list of

in alphabetical order,  971–992

by category,  993–1010

logical functions,  58–61, 291, 996

lookup and reference functions,  61–64, 307–308, 996. See 
also lookup and reference functions

mathematical functions,  90–92, 810–813, 1006–1007. See 
also mathematical functions

in names,  159–165

nesting,  142, 143, 153–155, 1012

ScreenTips for,  147

searching for,  151

statistical functions,  67–72, 381–385, 997–1002, 1014. See 
also statistical functions

syntax of,  143

text and data functions,  50–58, 255–256, 994–995. See 
also text

trigonometry functions,  90–92, 810–813, 1006–1007. See 
also trigonometry functions

for validation,  187–192

Function statement, VBA,  195

FV() function,  86–87, 87, 729–732

FVSCHEDULE() function,  732–734

G
GAMMADIST() and GAMMA.DIST() functions,  476–480

gamma distribution,  476–480, 481–482

gamma function, natural log of,  482–484, 484–485

GAMMAINV() and GAMMA.INV() functions,  481–482

GAMMA.INV() function,  481–482

GAMMALN() function,  482–484

GAMMALN.PRECISE() function,  484–485

Gauss error integrals,  963–966, 966–967

Gauss test,  632–634

GCD() function,  843–844

GEOMEAN() function,  485–486

geometric-degressive method of asset depreciation,  717–
718, 792–793

geometric mean,  485–486
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GESTEP() function,  969–970

GETPIVOTDATA() function,  664–672

Go To dialog box,  76, 165, 186

greater than operator (>),  107, 296, 639

greater than or equal to operator (>=),  107, 296, 639

greatest common divisor,  843–844

GROWTH() function,  487–491

H
HARMEAN() function,  491–494

harmonic mean,  491–494

help, for functions,  152–153

HEX2BIN() function,  918–920

HEX2DEC() function,  920–921

HEX2OCT() function,  921–922

hexadecimal system,  908

converting binary to,  911–912

converting decimal to,  915–917

converting octal to,  925–926

converting to binary,  918–920

converting to decimal,  920–921

converting to octal,  921–922

h format, for times,  43

higher mathematics functions,  906, 954–955

Bessel function of first kind,  957–959

Bessel function of second kind,  961–963

complement to Gauss error function,  966–967

modified Bessel function of first kind,  955–957

modified Bessel function of second kind,  959–961

probability integrals,  963–966

highlighting cells conditionally. See conditional formatting

HLOOKUP() function,  62, 316–318

Home tab

Conditional Formatting button,  166

Editing group, AutoSum button,  13

Number Format button,  42

Number group,  48

Accounting Number Format button,  10

Percent Style button,  17

Style group

Conditional Formatting button,  18, 60

Format As Table button,  12

Home tab (PowerPivot)

Get External Data group,  94

PivotTable arrow,  99

HOUR() function,  231–232

hyperbolic cosine,  834–835

hyperbolic sine,  879–881

hyperbolic tangent,  899–901

hypergeometric distribution,  494–497

HYPERLINK() function,  319–320

HYPGEOMDIST() and HYPGEOM.DIST() 
functions,  494–497

I
IBAN (International Bank Account Number), separating 

parts of,  53

icons

in conditional formatting. See KPI (Key Performance 
Indicator)

Wingdings font for,  58

IFERROR() function,  300–301, 1011, 1012

IF() function,  55, 60–61, 296–299

If-Then conditions, VBA,  206–210

IMABS() function,  935–937

IMAGINARY() function,  938

imaginary numbers. See complex number functions

IMARGUMENT() function,  939

IMCONJUGATE() function,  940

IMCOS() function,  940–941

IMDIV() function,  941–942

IMEXP() function,  942–944

IMLN() function,  944–945

IMLOG2() function,  946

IMLOG10() function,  945

IMPOWER() function,  946–948

IMPRODUCT() function,  948–949

IMREAL() function,  949

IMSIN() function,  950

IMSQRT() function,  950–951

IMSUB() function,  952

IMSUM() function,  953

INDEX() function,  62, 320–326

INDIRECT() function,  162, 178, 310, 326–327

individual data series,  4–7
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industrial (decimal) hours,  49–50

INFO() function,  356–359

information functions,  64–66

cell content,  348–352

cell formatting,  348–352

cell location,  348–352

cell reference, determining if,  369–371

data type of value, determining,  375–377

empty cells

determining if,  359–360

number of,  352–353

error in cell

determining if,  360–361, 361–362

type of,  354–356, 365–366

even number, determining if,  362–364

Excel status and version,  356–359

list of,  347–348, 997

logical value, determining if,  364–365

#N/A error, returning,  373–374

non-text value, determining if,  366–367

numeric value

converting to,  372–373

determining if,  367–368

odd number, determining if,  368–369

operating system information,  356–359

text value, determining if,  371–372

Insert Chart dialog box,  35

Insert Function dialog box,  149, 217

Insert tab

Chart group, Column button,  22

Tables group

PivotTable button,  29

Table button,  77

INTERCEPT() function,  497–500

interest,  85–89, 148–150

accrued interest,  695–697, 697–699, 713–714

annual interest rate in arrears for U.S. treasury 
bills,  788–789

anticipative interest rate,  720–722

anticipative interest yield,  690

compound interest,  690

duration of compound interest rate, annuity, or 
repayment,  747–750

effective annual interest rate,  727–729

interest payment for annuity,  736–738

interest rate for compound interest and 
annuities,  779–783

interest rate for marked down securities,  734–736

interest yield in arrears,  690

internal interest rate,  794–796

internal interest rate of dynamic investment,  738–740

nominal interest rate,  746

period interest rate, calculated from annual,  741–742

simple interest,  690

International Bank Account Number. See IBAN

intersection operator (“ “),  108, 110–111

INT() function,  845

INTRATE() function,  86, 734–736

inverse hyperbolic

cosine,  816–817

sine,  822–823

tangent,  827–828

inverse of an array,  851–854

investments,  89–90, 691

internal interest rate of dynamic investment,  738–740

internal yield of investment,  744–745

net cash value of future period surpluses,  750–752

IPMT() function,  736–738

IRR() function,  738–740

ISBLANK() function,  65, 359–360

ISERR() function,  65, 360–361

ISERROR() function,  65–66, 361–362

ISEVEN() function,  65, 362–364

ISLOGICAL() function,  65, 364–365

IsMissing() function, VBA,  205

ISNA() function,  365–366

ISNONTEXT() function,  65, 366–367

ISNUMBER() function,  65, 170–171, 367–368

ISODD() function,  65, 368–369

ISPMT() function,  741–742

ISREF() function,  65, 369–371

ISTEXT() function,  65, 371–372
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J
J format, for dates,  43

justification, determining for a cell,  349

K
keyboard, selections using,  124

keyboard shortcuts, specification of,  xxii

KPI (Key Performance Indicator)

with conditional formatting,  21

for cube data,  676–678

KURT() function,  68, 500–503

kurtosis,  68, 500–503

L
LARGE() function,  178, 503–505, 818. See also MAX() 

function

LCM() function,  846–847

leap years, calculating,  44

least common multiple,  846–847

LEFT() and LEFTB() functions,  51, 52, 53, 55, 160–161, 179, 
269–270

LEN() and LENB() functions,  52, 54, 55, 270–271

Len() function, VBA,  214

length measurements, conversions between,  927

less than operator (<),  107, 296, 639

less than or equal to operator (<=),  107, 296, 639

linear depreciation of assets,  702–703, 785–786

linear trends,  468–471, 613–618

line breaks, inserting in text,  57

line, statistics for,  506–511

LINEST() function,  506–511

links, creating,  319–320

liquid measurements, conversions between,  929

list boxes. See controls

lists (Excel 2003 only). See also tables (formerly called lists)

assigning dynamic names using,  77

LN() function,  847–848

loan repayments,  690. See amortization calculations; 
interest calculations

accrued interest between two points,  713–714

duration of repayment calculation,  747–750

repayment portion between two points,  715–717

locking cells. See protection

LOG10() function,  849–850

logarithm,  848–849, 849–850

of complex number,  944–945, 945, 946

natural,  847–848, 944–945

LOGEST() function,  511–515

LOG() function,  66, 848–849

logical conditions, VBA,  206–210

logical data type,  144

logical functions,  58–61. See also information functions

AND() function,  291–292

comparison operators in,  106–107

FALSE() function,  293–295

IFERROR() function,  300–301

IF() function,  296–299

list of,  291, 996

NOT() function,  301–302

OR() function,  302–304

TRUE() function,  304–306

logical value, determining whether cell is,  65

logical values

comparison operators for,  106–107

determining whether value or cell contains,  364–365

LOGINV() function,  518–519

lognormal distribution,  515–518, 518–519

LOGNORMDIST() and LOGNORM.DIST() 
functions,  515–518

LOGNORM.INV() function,  518–519

lookup and reference functions,  61–64

errors in,  65

list of,  307–308, 996

position based on lookup table,  330–333

value based on horizontal lookup table,  316–318

value based on lookup table,  328–329

value based on row and column number,  320–326

value based on vertical lookup table,  344–346

LOOKUP() function,  62, 328–329

loops, VBA,  212–214

LOWER() function,  272–273

M
Mac, 1904 date system used by,  42, 46

macros,  194, 218
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magnetic field intensity measurements, conversions 
between,  929

manual calculation of formulas,  134

MATCH() function,  62–63, 170–172, 330–333

mathematical functions,  90–92, 810–813. See also higher 
mathematics functions; trigonometry functions

absolute value,  813–814

aggregates,  818–821

combinations, number of,  830–831

determinant of an array,  850–851

division,  863

double factorial,  840–841

exponentiation,  838–839, 860–861

factorial,  839–840

greatest common divisor,  843–844

inverse of an array,  851–854

least common multiple,  846–847

list of,  811–813, 1006–1007

logarithm,  848–849, 849–850

multiplication,  862

multiplication of arrays,  854–855

pi constant,  859–860

polynomial coefficient,  858

power series, sum of,  873–875

random numbers,  865–866, 866–867

remainder of division,  855–857

rounding,  810

down to nearest multiple of significance,  841–842

down to next integer or multiple of significance,  842–
843

down to next smaller integer,  845

down to specified number of decimal places,  870–871

to nearest multiple,  857–858

to next integer or multiple of significance,  829–830

to smallest multiple of significance,  828–829

to specified number of decimal places,  869–870

up to nearest even integer,  837–838

up to nearest odd integer,  859

up to specified number of decimal places,  872–873

sign of a number,  876–877

square root,  881–882, 882–883

sum,  818, 885–886, 886–888, 888–889

of difference of squares,  892–893

of products,  890–891

of squared values,  891

of squares of differences,  895–896

of sum of squares,  893–895

truncation,  902

math operators. See arithmetic operators

MAXA() function,  521–522

MAX() function,  178, 520–521, 818. See also LARGE() 
function

maximum values,  520–521, 521–522, 649–650, 818

MDETERM() function,  850–851

MDURATION() function,  742–743

mean values

arithmetic mean,  390–392, 392–394, 395–398, 398–401, 
618–620, 641–643, 818

of cells,  71–72

of cells that are not empty,  80

geometric mean,  485–486

harmonic mean,  491–494

list of functions for,  67–68

median,  522–525, 818

mode,  528–529, 530

percentile,  548–550, 550–551, 551, 818

percent rank,  552–556

quartile,  563–566, 566–567, 567–568, 818

measurement systems, conversions between,  132, 
926–931

MEDIAN() function,  522–525, 818

median value,  522–525, 818

M format, for dates,  43

m format, for times,  43

MIDB() function,  273–274

MID() function,  53, 55, 161, 162, 273–274

Mid() function, VBA,  214

MINA() function,  526–527

MIN() function,  178, 525–526, 818. See also SMALL() 
function

minimum values,  525–526, 526–527, 581–582, 650–651, 
818
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minus sign (-)

correcting position of,  55

in date values,  41

negative value operator,  55, 106

subtraction operator,  104, 106

MINUTE() function,  232–233

MINVERSE() function,  851–854

MIRR() function,  744–745

mixed references,  115–117

MMULT() function,  854–855

mode,  528–529, 530

MODE() function,  528–529

MODE.MULT() function,  530

MODE.SNGL() function,  528–529, 818

MOD() function,  177, 855–857

money. See currency

month data series,  2–4

MONTH() function,  233–234

most frequent values (mode),  528–529, 530

mouse, selections using,  124–125

MROUND() function,  857–858

MULTINOMIAL() function,  858

multiple-rate method of asset depreciation,  719–720

multiplication,  818, 862

of arrays,  854–855

of column values,  652–654

of complex numbers,  948–949

multiplication operator (*),  104, 106

N
#N/A error

determining whether value or cell contains,  65, 365–366

included in ISERROR() results,  361

not included in ISERR() results,  360

returned by ERROR.TYPE() function,  354

returning #N/A error,  373–374

NA() function,  66, 373–374

#NAME? error,  217, 354

Name Manager,  162

names

custom lists of. See individual data series

defining,  160–161

dynamic range names,  163–165

formulas in,  159–165

names (of people)

reversing parts of,  52

separating parts of,  51–52

natural logarithm,  847–848, 944–945

negative binomial distribution,  531–532

negative value operator (-),  106

NEGVINOM.DIST() function,  531–532

NEGVINOMDIST() function,  531–532

NETWORKDAYS() function,  234–235

NETWORKDAYS.INTL() function,  236–237, 1014

New Formatting Rule dialog box,  18

newline character,  57

New Name dialog box,  74, 76, 161

N() function,  372–373

NOMINAL() function,  746

normal distribution,  533–536, 537–539, 539–541, 542–544, 
583–585

NORMDIST() and NORM.DIST() functions,  533–536

NORMINV() and NORM.INV() functions,  537–539

NORMSDIST() and NORM.S.DIST() functions,  539–541

NORMSINV() and NORM.S.INV() functions,  542–544

not equal to operator (<>),  107, 296, 639

NOT() function,  301–302

NOW() function,  237–238

NPER() function,  747–750

NPV() function,  750–752

#NULL! error,  354

number data type,  144

numeric values

absolute value of,  813–814

aggregates of,  818–821

binary system for,  907, 908–909

complex numbers. See complex number functions

conversions of. See conversion functions

from numeric values to numerals in Thai text,  257–258

from numeric values to text formatted as curren-
cy,  262–263

from numeric values to text in number format,  285–
286

from numeric values to text with specified decimal 
places,  268–269

from text to a numeric value,  289–290
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converting a value to,  372–373

decimal system for,  907

determining if value or cell contains,  367–368

determining whether cell contains,  65

in engineering calculations. See engineering functions

even, determining whether cell is,  65

even, determining whether value is,  362–364

in financial calculations. See financial functions

formatting

as currency,  10

functions for, list of,  255–256

hexadecimal system for,  908

in mathematical calculations. See mathematical functions

octal system for,  908

odd, determining whether cell is,  65

odd, determining whether value is,  368–369

sign of,  876–877

in statistical calculations. See statistical functions

in trigonometry calculations. See trigonometry functions

visualizing with repeating cell graphics,  58

#NUM! error,  354

O
object-oriented programming,  215

OCT2BIN() function,  922–924

OCT2DEC() function,  924

OCT2HEX() function,  925–926

octal system,  908

converting binary to,  912–913

converting decimal to,  917–918

converting hexadecimal to,  921–922

converting to binary,  922–924

converting to decimal,  924

converting to hexadecimal,  925–926

ODDFPRICE() function,  752–755

ODD() function,  859

ODDFYIELD() function,  755–757

ODDLPRICE() function,  757–759

ODDLYIELD() function,  759–761

odd number, determining whether cell is,  65

OFFSET() function,  63–64, 333–337

OLAP (online analytical processing) cubes. See cube 
functions

OLAP tools,  84

one’s complement, for binary system,  909

online analytical processing (OLAP) cubes. See cube 
functions

operands,  103–104. See also constants; references

operating system, information about,  356–359

operators,  103–104, 104–111

arithmetic operators,  104–106

comparison operators,  106–107, 296

priority of, specifying,  105–106

reference operators,  108–111

for search criteria,  639

text operator (&),  107–108

Optional keyword, VBA,  204

OR() function,  302–304

P
P0 or P2, indicating percentage formats,  350

parameters. See arguments, of functions

parentheses (())

cells formatted with, determining,  349

enclosing function arguments,  143

grouping expressions in formulas,  105–106

highlighting of,  106

Paste Special dialog box,  92

path

of current directory,  357

of workbook,  160–161

Pearson correlation coefficient,  544–547, 572–574

PEARSON() function,  544–547

PERCENTILE.EXC() function,  550–551, 818

PERCENTILE() function,  548–550

PERCENTILE.INC() function,  551, 818

percentile (p quantile),  548–550, 550–551, 551, 818

percent operator (%),  104, 106

PERCENTRANK.EXC() function,  554

PERCENTRANK() function,  552–553

PERCENTRANK.INC() function,  555–556

performance measurements, conversions between,  928

permutations,  556–557

PERMUT() function,  556–557

PHONETIC() function,  275
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pi

constant for,  859–860

square root of number multiplied by,  882–883

pie charts,  24–25

PI() function,  214–215, 859–860

PivotCharts,  35–40

changing settings for,  39

creating,  35–37

dynamically changing data in,  38–39

using with PowerPivot,  99–101

PivotTable dialog box,  30

PivotTables,  28–34

converting to a cube,  84

creating,  29–31

creating PivotCharts from,  35–37

dynamically changing data in,  38–39

filtering data,  31–34

reports, retrieving data from,  664–672

using with PowerPivot,  93, 99–101

plus sign (+)

addition operator,  104, 106

in keyboard shortucuts,  xxii

PM designation, for times,  43

PMT() function,  149–150, 179, 762–764

POISSON.DIST() function,  558–560

Poisson distribution,  558–560

POISSON() function,  558–560

polynomial coefficient,  858

position,  568–570, 570–571, 571–572. See also relative 
position

POWER() function,  860–861

PowerPivot add-in,  93–102, 1015

power series, sum of,  873–875

PPMT() function,  765–766

pressure measurements, conversions between,  928

price calculations,  691. See also securities

PRICEDISC() function,  85, 771–774

PRICE() function,  767–771

PRICEMAT() function,  774–776

probability,  69, 70, 561–563

probability integrals,  963–966

probability theory,  67

PROB() function,  561–563

PRODUCT() function,  818, 862

products, sum of,  890–891

profit, calculating,  59–61

profit margin, calculating,  11, 13–17

PROPER() function,  275–276

protection

determining, for a cell,  349

preventing cells and formulas from being 
changed,  132–133

validation of data as,  188

Public keyword, VBA,  200

PV() function,  776–779

Q
quantiles

of gamma distribution,  476–480, 481–482

left quantile

of chi-squared distribution,  413–414, 416–417

of F-distribution,  452–453, 456

of lognormal distribution,  518–519

p quantile (percentile),  548–550, 550–551, 551

right quantile

of chi-squared distribution,  414–416, 418–419

of F-distribution,  453–455, 457–459

quarters of the year, calculating,  49

QUARTILE.EXC() function,  566–567, 818

QUARTILE() function,  563–566

QUARTILE.INC() function,  567–568, 818

quartiles,  563–566, 566–567, 567–568, 818

question mark (?), wildcard,  637, 639

quotes

double quote (“), indicating right-aligned text,  349

double quotes (“”)

enclosing text or spaces in cells,  107, 108

enclosing text with wildcards,  639

single quote (‘), indicating left-aligned text,  349

QUOTIENT() function,  863

R
radians

converting degrees to,  863–865

converting to degrees,  835–837
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RADIANS() function,  153–155, 863–865

RAM usage,  1012

RANDBETWEEN() function,  7–8, 91–92, 866–867

RAND() function,  865–866

random numbers, generating,  7–8, 91–92, 865–866, 
866–867

range names, dynamic,  163–165

range operator (:),  108–110

ranges. See cell ranges

RANK.AVG() function,  570–571

RANK.EQ() function,  571–572

RANK() function,  568–570

RATE() function,  779–783

real-time data, retrieving,  339–341

RECEIVED() function,  783–785

records, in database,  635. See also database; database 
functions

reference data type. See cell reference data type

reference functions. See lookup and reference functions

reference lines in tables, highlighting,  179–182

reference operators,  108–111

references. See cell references

#REF! error,  354

regression analyses,  68

exponential curve for,  511–515

intercept point of regression line,  497–500

line statistics,  506–511

slope of regression line,  578–581

relative position,  552–553, 554, 555–556. See also position

relative references,  113, 117. See also mixed references

remainder of division,  855–857

repayment calculations. See loan repayments

REPLACE() and REPLACEB() functions,  276–277

REPT() function,  58, 278–279

return value, for custom function,  200

RIGHT() and RIGHTB() functions,  50, 51, 52, 53, 55, 162, 
179, 279–280

ROMAN() function,  811, 867–869

Roman numerals, converting Arabic numbers to,  867–869

ROUNDDOWN() function,  870–871

ROUND() function,  87, 869–870

rounding,  810

down to nearest multiple of significance,  841–842

down to next integer or multiple of significance,  842–843

down to next smaller integer,  845

down to specified number of decimal places,  870–871

to nearest multiple,  857–858

to next integer or multiple of significance,  829–830

to smallest multiple of significance,  828–829

to specified number of decimal places,  869–870

up to nearest even integer,  837–838

up to nearest odd integer,  859

up to specified number of decimal places,  872–873

ROUNDUP() function,  872–873

ROW() function,  337–338

row limits, with PowerPivot,  93

row number, determining for a cell,  349

rows

highlighting alternate rows,  176–177

limits for,  1012

references to entire rows,  109–110

ROWS() function,  338–339

rows, in database,  635. See also database; database 
functions

RSQ() function,  572–574

RTD() function,  339–341

Rules Manager,  166

S
saltus functions,  906, 967–970

sample files for this book,  xxiii–xxxv

ScreenTips, for functions,  147

search and reference functions. See lookup and reference 
functions

SEARCH() and SEARCHB() functions,  281–283

search criteria for database functions,  636–638

calculated criteria in,  639

including all records,  638

including all records with an empty field,  639

multiple conditions in,  639

operators and wildcards for,  639

searching for functions,  151

searching worksheets. See lookup and reference functions
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SECOND() function,  238–239

securities

annual yield for marked down security,  803–806

anticipative interest rate,  720–722

decimal places as numerator of fraction, converting,  723–
724, 724–725

disbursement amount of simply discounted 
security,  771–774

fixed-interest

accrued interest of,  695–697, 697–699

annual yield of,  806–808

date of first interest payment,  708–709

date of last interest payment,  711–712

days in interest period,  705–706

days since last interest payment,  704–705

days to next coupon date,  707–708

Macauley Duration for,  725–727

modified duration for,  742–743

number of interest payments,  710–711

price of,  752–755, 757–759, 767–771

yield of,  755–757, 759–761, 799–803

marked down, interest rate for,  734–736

price of discounted securities as percent,  789–790

price of security with simple interest yield in 
arrears,  774–776

yield of discounted security,  790–791

selections,  124–125

SERIES() function,  64

SERIESSUM() function,  873–875

s format, for times,  43

SharePoint 2010, publishing PowerPivot results to,  93, 96

sheet

name of, determining,  162

number of active worksheets,  357

references to entire worksheet,  110

SIGN() function,  876–877

sign of a number,  876–877

simple interest,  690

S, indicating fraction format,  350

S, indicating standard format,  350

sine,  877–879, 950

SIN() function,  153–155, 877–879

single quote (‘), indicating left-aligned text,  349

SINH() function,  879–881

64-bit version, Excel 2010,  1013

SKEW() function,  68, 575–578

skewness of a distribution,  575–578

slash (/). See forward slash (/)

SLN() function,  785–786

SLOPE() function,  578–581

slope of regression line,  578–581

SMALL() function,  178, 581–582, 818. See also MIN() 
function

Solver add-in,  1015

sort keys, limits for,  1012

space (“ “)

in database record,  638

in functions, avoiding,  144

highlighting cells containing,  179

including in cells,  108

intersection operator,  108, 110–111

removing from text,  54–55

in search criteria,  638

sparklines,  28

spread,  68–69

SQL Server Analysis Services,  673. See also cube functions

SQRT() function,  881–882

SQRTPI() function,  882–883

squared deviations, sum of,  446–448

squared values

sum of,  891

sum of differences of,  892–893

sum of sum of,  893–895

square root,  881–882, 882–883, 950–951

standard deviation

based on population,  585–587, 818

based on population, including text and logical 
values,  593–595

based on population in database,  656–657

based on sample,  588–590, 818

based on sample, including text and logical 
values,  590–592

based on sample in database,  654–655

standard error,  595–598

standardized normal distribution,  583–585

STANDARDIZE() function,  583–585
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statistical functions,  67–72, 1014

average absolute deviation,  388–389

beta distributions,  401–403, 403–407

binomial distributions,  407–411, 411–413

chi-squared distributions,  413–414, 414–416, 416–417, 
418–419, 420–422

compatibility category of,  385

confidence interval,  423–426, 427

correlation,  68, 428–431

counting,  69–70, 71

all numbers in argument list,  431–433, 818

all numbers in database matching search criteria,  643–
645

all values in argument list,  434, 818

all values in database matching search criteria,  645–
647

all values matching search criteria,  435–438, 438–440

empty cells,  435

covariance,  441–444, 444–445, 445–446

examples using, scenario for,  387

exponential distributed random variable, probability 
of,  448–451

exponential trend,  487–491

F-distribution,  452–453, 453–455, 456, 457–459

Fisher transformation,  462–466, 467

frequency distribution,  472–476

f-test, statistics from,  460–462

gamma distribution,  476–480, 481–482

gamma function, natural log of,  482–484, 484–485

Gauss test,  632–634

kurtosis,  500–503

linear trends,  468–471, 613–618

list of,  381–385, 997–1002

lognormal distribution,  515–518, 518–519

maximum values,  503–505, 520–521, 521–522, 818

mean values,  67–68, 71–72

arithmetic mean,  390–392, 392–394, 395–398, 
398–401, 618–620, 641–643, 818

geometric mean,  485–486

harmonic mean,  491–494

median,  522–525, 818

mode,  528–529, 530

percent rank,  552–553

minimum values,  525–526, 526–527, 581–582, 818

negative binomial distribution,  531–532

normal distribution,  533–536, 537–539, 539–541, 
542–544

Pearson correlation coefficient,  544–547, 572–574

permutations,  556–557

Poisson distribution,  558–560

position,  568–570, 570–571, 571–572

p quantile (percentile),  548–550, 550–551, 551, 818

probability,  69, 70, 561–563

quartiles,  563–566, 566–567, 567–568

regression analyses,  68

exponential curve for,  511–515

intercept point of regression line,  497–500

line statistics,  506–511

slope of regression line,  578–581

relative position,  552–553, 554, 555–556

skewness of a distribution,  575–578

spread,  68–69

squared deviations, sum of,  446–448

standard deviation. See standard deviation

standard error,  595–598

standardized normal distribution,  583–585

symmetry,  68

t-distribution,  599, 600, 601–602, 603, 604–606

t-test,  606–612

uses of,  380–381

variance,  68–69

based on population,  620–622, 818

based on population, including text and logical val-
ues,  627–628

based on population in database,  662–663

based on sample,  622–624, 818

based on sample, including text and logical val-
ues,  625–626

based on sample in database,  661–662

Weibull distribution,  629–632

STDEVA() function,  590–592

STDEV() function,  588–590

STDEVPA() function,  593–595

STDEVP() and STDEV.P() functions,  585–587, 818

STDEV.S() function,  588–590, 818

STEYX() function,  595–598
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Str() function, VBA,  213

strings. See text

SUBSTITUTE() function,  54, 54–55, 283–284

SUBTOTAL() function,  883–885

subtraction of complex numbers,  952

subtraction operator (-),  104, 106

sum,  818, 885–886, 886–888, 888–889

of complex numbers,  953

of difference of squares,  892–893

of a power series,  873–875

of products,  890–891

of squared values,  891

of squares of differences,  895–896

of sum of squares,  893–895

of values in database,  657–660

SUM() function,  90, 141–142, 143–146, 818, 885–886

SUMIF() function,  90–91, 886–888

SUMIFS() function,  888–889, 1011, 1012

summarizing tabular data. See PivotTables

SUMPRODUCT() function,  890–891

SUMSQ() function,  891

SUMX2MY2() function,  892–893

SUMX2PY2() function,  893–895

SUMXMY2() function,  895–896

support information for this book,  xxxvi

SYD() function,  786–787

symmetry,  68

T
table names, in formulas,  311

tables

formatting data as,  12–13

for summarizing or filtering data. See PivotTables

tables (formerly called lists). See also PivotTables

assigning dynamic names using,  77–78

automatic formula calculation excluding,  134

comparing,  174–176

reference lines in,  179–182

relative references in,  117

TAN() function,  896–899

tangent,  896–899

TANH() function,  899–901

TBILLEQ() function,  788–789

TBILLPRICE() function,  789–790

TBILLYIELD() function,  790–791

TDIST() and T.DIST.2T() functions,  601–602

T.DIST() function,  599

t-distribution,  70, 599, 600, 601–602, 603, 604–606

T.DIST.RT() function,  600

technical functions. See engineering functions

temperature measurements, conversions between,  929

testing custom functions,  202

text,  50–58

in cells, enclosing in quotes (“”),  107, 108

comparing two strings,  264–265

conversions of

from character code to character,  258–259

from character to character code,  260–261

from double-byte to single-byte characters,  256–257

from text to cell reference,  326–327

from numeric values to numerals in Thai text,  257–258

from numeric values to text formatted as curren-
cy,  262–263

from numeric values to text in number format,  285–
286

from numeric values to text with specified decimal 
places,  268–269

from text to a numeric value,  289–290

determining if value or cell contains,  366–367

determining whether a string is,  65, 284–285

determining whether value is,  371–372

extracting parts of

in addresses,  50–52

in IBAN numbers,  53

last characters of a string,  279–280

middle characters of a string,  273–274

phonetic Furigana characters,  275

frequency of a character in,  54

functions for, list of,  255–256, 994–995

length of string,  270–271
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manipulating

changing all characters to lowercase,  272–273

changing all characters to uppercase,  287–289

changing first character of all words to upper-
case,  275–276

concatenating multiple strings,  56–57, 261–262

line breaks, inserting,  57

removing all non-printable characters,  259–260

removing all spaces in,  54–55

removing leading or trailing spaces,  286–287

repeating characters a specified number of times,  278–
279

replacing characters,  276–277, 283–284

reversing parts of,  52

searching for a string within,  266–267, 281–283

wrapping, enabling,  57

text data type,  144

TEXT() function,  285–286

text operator (&),  107–108

T format, for dates,  43

T() function,  284–285

TIME() function,  239–240

times. See dates and times

TIMEVALUE() function,  241

TINV() and T.INV.2T() functions,  70, 604–606

T.INV() function,  70, 603

T.INV.RE() function,  70

TODAY() function,  163, 242

tracing formulas,  136–137

TRANSPOSE() function,  341–343

treasury bills

annual interest rate in arrears for U.S. treasury 
bills,  788–789

price of discounted securities as percent,  789–790

yield of discounted security,  790–791

TREND() function,  613–618

trends. See probability

trigonometry functions,  90–92, 810. See 
also mathematical functions

adjacent angle, based on sine,  821–822

arccosine,  814–816

arctangent,  824–825, 825–826

converting degrees to radians,  863–865

converting radians to degrees,  835–837

cosine,  832–834, 940–941

hyperbolic cosine,  834–835

hyperbolic sine,  879–881

hyperbolic tangent,  899–901

inverse hyperbolic cosine,  816–817

inverse hyperbolic sine,  822–823

inverse hyperbolic tangent,  827–828

list of,  811–813, 1006–1007

natural logarithm,  847–848, 944–945

sine,  877–879, 950

tangent,  896–899

TRIM() function,  179, 286–287

TRIMMEAN() function,  391, 618–620

troubleshooting

conditional formatting,  187

formulas,  138–140

TRUE() function,  304–306

truncation,  902

TRUNC() function,  902

t-test,  606–612

TTEST() and T.TEST() functions,  606–612

two’s complement, for binary system,  909

TYPE() function,  375–378

Type statement, VBA,  195

type styles used in this book,  xxii

U
underscore (_), continuing lines in custom functions,  205

UPPER() function,  287–289

U.S. treasury bills

annual interest rate in arrears for U.S. treasury 
bills,  788–789

price of discounted securities as percent,  789–790

yield of discounted security,  790–791
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V
Val() function, VBA,  214

validation

dependencies on other cells,  188–189

duplicate entries, avoiding,  190–192

formulas for,  187–192

limits on length of data,  188

messages displayed on completion of entries,  192

#VALUE! error,  354

VALUE() function,  289–290

VARA() function,  625–626

VAR() function,  622–624

variables. See names

variables, VBA,  213–214

variance,  68–69

based on population,  620–622, 818

including text and logical values,  627–628

in database,  662–663

based on sample,  622–624, 818

including text and logical values,  625–626

in database,  661–662

VARPA() function,  627–628

VARP() and VAR.P() functions,  620–622, 818

VAR.S() function,  622–624, 818

VBA (Visual Basic for Applications),  193

branching,  206–210

comments,  201

conditions,  206–210

creating custom functions using. See custom functions

End Function statement,  195

Function statement,  195

IsMissing() function,  205

Len() function,  214

loops,  212–214

Mid() function,  214

Optional keyword,  204

Public keyword,  200

Str() function,  213

Type statement,  195

Val() function,  214

variables,  213–214

VDB() function,  792–793

Visual Basic Editor,  193

closing and returning to Excel,  202

opening,  196

Visual Basic for Applications. See VBA (Visual Basic for 
Applications)

VLOOKUP() function,  62–63, 65, 344–346

W
W0 or W2, indicating currency formats,  350

WEEKDAY() function,  243–245

WEEKNUM() function,  246–247

WEIBULL.DIST() function,  629–632

Weibull distribution,  629–632

WEIBULL() function,  629–632

weight measurements, conversions between,  927

wildcards for search criteria,  639

Wingdings font,  58

workbook

file name of, determining,  55, 161, 349

number of active worksheets in,  357

path for, determining,  160–161

recalculation mode for, determining,  357

WORKDAY() function,  247–249

WORKDAY.INTL() function,  249–251, 1014

worksheet. See sheet

wrapping cells, enabling,  57

X
XIRR() function,  794–796

.xlam file extension,  1013

.xlsb file extension,  1013

.xlsm file extension,  218, 1013

.xlsx file extension,  218, 1013

.xltm file extension,  1013

.xltx file extension,  1013

XML, file formats using,  1013

XNPV() function,  796–798

Y
YEARFRAC() function,  252–254

YEAR() function,  251–252

YIELDDISC() function,  86, 803–806



	﻿ 	 1043

YIELD() function,  799–803

YIELDMAT() function,  806–808

Z
Z.TEST() function,  632–634

ZTEST() function,  632–634
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What do  
you think of  
this book?
We want to hear from you! 
To participate in a brief online survey, please visit: 

Tell us how well this book meets your needs—what works effectively, and what we can  
do better. Your feedback will help us continually improve our books and learning  
resources for you.   

Thank you in advance for your input!

microsoft.com/learning/booksurvey 
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